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PART 1: ON1 EFFECTS 2020 OVERVIEW

ON1 Effects 2020 is a complete stylizing tool for your photos. With a professional-grade effects engine that 
includes 30 filters, Effects gives you endless possibilities for finishing your photos, with extensive stacking, 
masking and blending options; hundreds of borders and textures; and a set of local adjustment tools for 
applying basic tone and color options to your images. To help get you started, Effects comes with more than 
100 built-in presets, and you can save and apply your own presets with the click of a button.

You can use ON1 Effects 2020 as a standalone app, simply by dragging and dropping photos, or as a plug-in 
to a photo editor such as Adobe’s Photoshop, Lightroom Classic CC, Photoshop Elements or Apple Photos. 

Using the Help System
You can find and watch free video tutorials at the ON1 Product Training site, available at ON1.com. This 
is the best and quickest way to dig into the ON1 workflow and discover new techniques that will help you 
with your photo editing and organizing. There, you can search our Knowledge Base for frequently asked 
questions, common issues and more. 

The Help menu in ON1 Effects 2020 includes links to the training site, as well as our extensive library of 
video tutorials and more. 

https://www.on1.com/blog/category/product-training/
https://on1help.zendesk.com/hc/en-us
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System Requirements
MINIMUM RECOMMENDED

OPERATING SYSTEM macOS 10.12 through 10.15; 
Windows 7, 8 or 10 releases, 
64-bit only

macOS 10.14 or 10.15; 
Windows 10 current releases, 
64-bit only

PROCESSOR Intel Core i5, Xeon or better 
processor

4-core Intel Core i5, Xeon or 
better processor

RAM 8 GB 16 GB

HARD DRIVE 1.5 GB for installation 1.5 GB for installation 
Fast (7200 RPM) or SSD drives

DISPLAY OpenGL 3.3 compatible video 
card with 512 MB video RAM, 
1280x720 resolution

OpenGL 4.2 compatible video 
card with 2 GB dedicated video 
RAM, 1920x1080 resolution

THIRD-PARTY APPS 
SUPPORTED (PLUG-IN)

Photoshop CS6; 
Photoshop Elements 14 
Lightroom Classic 6; 
Apple Photos

Photoshop CC 2018; 
Photoshop Elements 2018 
Lightroom Classic CC 2018;  
Apple Photos

OTHER Internet connection for 
activation and auto update 
checking.

Internet connection for 
activation and auto update 
checking; Wacom tablet for 
pressure-sensitive input; 
hardware display calibration tool

Installation
To install ON1 Effects 2020, double-click the installer icon and allow the installer to guide you. Before 
installing or updating, close any supported host applications, such as Adobe Photoshop, Photoshop 
Elements, Lightroom or Apple Photos, as well as any previous versions of ON1 products.

MACOS
The application is installed in the ON1 Effects 2020 folder in the Applications folder. All plug-in files for 
supported host applications (such as Adobe Photoshop, Lightroom, Photoshop Elements or Apple Photos) 
found during the installation process will be installed automatically; a summary of installed plug-ins will be 
displayed at the end of installation.

If an earlier version of Effects is found, it will be kept or replaced based on your installation preference.

Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folders.

WINDOWS
The application is installed in the ON1 Effects 2020 folder in the \Program Files\ON1\ directory. All 
plug-in files for supported host applications (such as Adobe Photoshop, Lightroom, Photoshop Elements) 
found during the installation process will be installed automatically; a summary of installed plug-ins will be 
displayed at the end of installation.
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If an earlier version of Effects is found, it will be kept or replaced based on your installation preference.

Support files are installed into \ProgramData\ON1\.

Launching ON1 Effects 2020
To run Effects 2020, follow these steps:

MACOS

1.	 Open your Finder.

2.	 Navigate to the Applications folder.

3.	 Navigate to the ON1 Effects 2020 folder.

4.	 Double-click on the ON1 Effects 2020 application icon.

You can add ON1 Effects 2020 to your dock for easy access by clicking and holding the icon in the dock 
and selecting the Keep In Dock option. If you use Launchpad it can be found there as well.

WINDOWS 7

1.	 Go to your Start Menu.

2.	 Select the ON1 group.

3.	 Select ON1 Effects 2020.

4.	 If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
Effects 2020 from there.

WINDOWS 8.1 AND WINDOWS 10

1.	 Open the Start screen by pressing the Window key.

2.	 Select ON1 Effects 2020.

3.	 If you selected the “Add Icon to Desktop” option during installation you can also access ON1 
Effects 2020 from there.

To launch ON1 Effects 2020 from an external application, such as Adobe Photoshop or Lightroom, see the 
sections below for complete instructions.
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OPENING A PHOTO FROM WITHIN EFFECTS

When you first launch Effects, the main 
window will have an icon in the center and 
an Open Photo button. To start working 
on a photo, you can either drag a photo 
from your desktop onto the icon, or you 
can click on the Open Photo button, both 
of which will open the primary Effects 
window, where you can start applying 
filters and other edits to your photos. (See 
“Part 2: Working in Effects 2020” on page 
14 for detailed information on using 
Effects’ filters and tools on your photos.)

On both MacOS and Windows, you can 
also drag a photo on top of the Effects 
2020 icon, which will launch the app with that image, bypassing the startup window.

Licensing and Registration
When you open a photo inside ON1 Effects 2020, the upper left side of the main window will have two 
buttons, Buy Now and Sign-In. 

IF YOU HAVE PURCHASED ON1 EFFECTS 2020:

Click on the “Sign-in” button and fill in your ON1 
account information (email and password) to register 
the app with us. (You should have set up an account 
when you purchased the software.) If the computer 
you are signing in with does not have access to the 
internet, you can manually register your software by 
clicking on the “No Internet connection” link in the 
license dialog.

Your license lets you install ON1 Effects 2020 on five computers. When you enter your ON1 account info, 
Effects 2020 communicates with the ON1 activation server and registers your software for that computer.

If you wish to move your copy of Effects from one registered computer to a new one, and you are not going 
to be using the older machine, it is best to sign out of the old computer first. Open Effects and select Sign 
Out from the Help menu. This will deactivate Effects 2020 on the current machine, and you can install and 
sign in on another machine.

You can log into your ON1 user account area (https://www.on1.com/login/) at any time to download the 
software, see the number of computers you have registered, and make basic changes to your account 
information, including your email address, password, and notifications.

If you have issues related to installing or activating Effects, please contact ON1 customer support, which 
can be reached by clicking on the ON1 website’s Support tab (https://on1help.zendesk.com).

You can edit a photo directly from within ON1 Effects by dragging a file into the 
window, or by clicking on the Edit Photo button.

When you first open a photo in ON1 Effects, sign in with your ON1 
User ID (which you set up when you purchased the software) If you 
downloaded the app to try out, you can see how many days are left in 
your free trial.

https://www.on1.com/login/
https://on1help.zendesk.com
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TRIAL VERSION

ON1 Effects 2020 can also operate as a fully featured trial version for 30 days from when you first launch 
it. This gives you time to evaluate the product and see if it fits your needs. Each time you launch Effects 
during the trial period, the Buy Now button will tell you how many days remain in the trial.

You can purchase ON1 Effects 2020 at any time by clicking on the Buy Now button. Once you do that, click 
the Sign-In button the next time you launch the product and enter your ON1 account information. If your 
trial period has ended, Effects will present you with an activation window when you launch the app. There, 
you can enter your ON1 account info to activate the app. If you do not wish to purchase the app, you can 
uninstall the app as detailed below.

PRODUCT IMPROVEMENT PROGRAM

We believe that the best products are made by listening to our customers. We use many methods to 
gather your ideas and feedback including: emails, surveys, direct conversations, market analysis and the 
Product Improvement Program. The Product Improvement Program is built into our software and gathers 
information about how our software is used. It is the most accurate way for us learn what features are 
important to you and how our products fit into your workflow.

Enrollment in the program is voluntary. When you participate, we collect basic information about how you 
use our programs and basic information about your computer. This information helps us learn what features 
are important to you and how we can make our software easier to use. No personal information is collected 
and you will not be contacted.

You can choose to participate in the Product Improvement Program the first time you launch ON1 Effects 
2020. You can change your participation later, just click the Help menu, then Help Improve ON1 Products.

To learn more about the Product Improvement Program, go to the Support area of the ON1.com website.

Uninstalling ON1 Effects 2020
To uninstall ON1 Effects 2020, first, deactivate your product: open ON1 Effects 2020 and select Sign 
Out… from the Help menu. (This will allow you to transfer your license to another computer.)

MACOS

1.	 Go to the Applications/ON1 Effects 2020/Documentation folder.

2.	 Double-click on the Remove ON1 Effects 2020 application.

WINDOWS

1.	 Go to Control Panels.

2.	 Under Programs select Uninstall a program.

3.	 In the list that comes up select ON1 Effects 2020 and then click on the Uninstall button.
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Working with Files
ON1 Effects 2020 can view and open the following file types, in RGB color mode, at 8 or 16 bits per pixel:

• Raw files from most major camera manufacturers (file extension varies by manufacturer)

• Digital Negative (DNG)

• Photoshop (PSD)

• Photoshop Large Document (PSB)

• Tagged Image File Format (TIFF)

• Joint Photographic Experts Group (JPEG)

• Portable Network Graphic (PNG)

•	 High Efficiency Image Format (HEIC) 

When you finish working on a photo in Effects, you have the option of saving your resulting file in PSD, 
PSB, TIFF, JPEG, and PNG format.

FILE ACCESS WHEN USING EFFECTS 2020 AS A PLUG-IN

If you use ON1 Effects 2020 as a plug-in from another image editing app (Lightroom, for example), we 
recommend using the Photoshop format (.PSD) as the exchange file format for maximum compatibility. If 
your saved file will be larger than 2GB, or more than 30,000 pixels on a side, your image will automatically 
be saved in the .PSB (or Large Document) format. This is a newer version of the PSD format designed for 
larger file sizes, and is fully compatible with Effects.

Using ON1 Effects 2020 with Adobe® Photoshop®
When you edit an image sent from Photoshop to ON1 Effects 2020, you are editing Photoshop’s currently 
selected layer. By default, Effects makes a copy of the layer, so your original layer is saved, unless it 
is a Smart Object (see below). If you’d like to change this preference, see the Plug-Ins section of the 
Preferences window on page 87.

ON1 Effects 2020 is accessible from within Photoshop in two ways, from the File > Automate menu, and 
from the Filter > ON1 menu. 

There are two options for editing an image in ON1 Effects 2020: you can send the layer to Effects for final 
editing, or you can save the editing layer as a Smart Object in Photoshop, which will let you re-edit the 
photo in Effects with your previous settings intact.



ON1 Effects 2020 User Guide	 Part 2: Overview	 7

EDITING A PHOTO FROM PHOTOSHOP FOR FINAL EDITING

To use Effects inside Photoshop, when you do not wish so be able to re-edit your operations, follow these 
steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on. (Depending upon your Plug-Ins Preference, make a 
duplicate if you want to preserve the original layer (Layer > Duplicate))

3.	 From the Filter menu, select ON1 and then ON1 Effects 2020.

4.	 When you’re finished editing your photo, click the Done button in Effects. 

EDITING A PHOTO FROM PHOTOSHOP TO PRESERVE EFFECTS EDITS

To be able to re-edit your Photoshop images at a later point inside ON1 Effects 2020, you will use 
Photoshop’s Smart Object technology. To do this, follow these steps:

1.	 Open the image you want to work on in Photoshop.

2.	 Select the layer you want to work on.

3.	 Right-click on the layer and choose Convert to Smart 
Object.

4.	 From the Filter menu, select ON1 and then ON1 Effects 
2020.

5.	 When you’re finished editing your photo, click the Done 
button in Effects.

To re-edit your Smart Object layer again inside ON1 Effects 2020, 
double-click on the ON1 Effects item in the edited Smart Object layer 
in Photoshop. Effects will then launch and let you adjust your 
previous settings or make new ones.

Right-clicking on a layer in Photoshop’s Layers 
panel gives you the option to turn the layer into a 
Smart Object..

To re-edit a Photoshop layer in 
Effects, double-click the module 
name in the Smart Filters section of 
the Layers palette.
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Using ON1 Effects 2020 with Photoshop Elements®
When you edit an image sent from Photoshop Elements to ON1 Effects 2020, you are editing Photoshop 
Elements’ currently selected layer. By default, Effects makes a copy of the layer, so your original layer is 
saved. If you’d like to change this preference, see the Plug-Ins section of the Preferences window (page 
87).

EDITING A PHOTO IN PHOTOSHOP ELEMENTS

To use Effects inside Photoshop Elements, follow these steps:

1.	 Open the image you want to work on in Photoshop Elements.

2.	 Select the layer you want to work on. 

3.	 From the Filter menu, select ON1 and then ON1 Effects 2020.

4.	 When you’re finished editing your photo, click the Done button in Effects.

Using Effects with Adobe® Lightroom® Classic CC
ON1 Effects 2020 can be accessed from within Lightroom Classic CC, providing an integrated, round-trip 
workflow of your images. 

There are two primary ways to use ON1 Effects 2020 with Lightroom, via the Plug-In Extras command in 
the File menu and the Edit In command in the Photo menu. Both generally work the same way, the primary 
difference being where you choose the file format of the photo being opened in Effects. Using Plug-In 
Extras opens the file using the format chosen in Effects’ Plug-Ins Preferences pane, while Edit In lets you 
choose the file format inside Lightroom.

USING ‘PLUG-IN EXTRAS’

To edit an image in ON1 Effects 2020, select the 
image in Lightroom, go the File menu and select 
the Plug-In Extras submenu, and choose ON1 
Effects 2020 Standalone. 

File Creation Characteristics When Using Plug-In Extras

When you access ON1 Effects 2020 through the Plug-In Extras menu there are important file-handling 
options that are controlled in the Files tab of the Effects Preferences window. These need to be configured 
in advance, based on your desired workflow. Once these are set, all images sent to Effects 2020 via the 
Plug-In Extras submenu will use these characteristics:

The Plug-In Extras submenu is found in Lightroom Classic’s File menu. 
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• File Format: The file type drop-down menu 
determines what type of file will be created. 
The default is PSD, which maintains layers. 
You can also select JPG or TIFF, if you prefer 
those formats.

• Color Space: The color space drop-down menu 
determines what RGB working color space is 
used; Adobe RGB 1998, sRGB or ProPhoto 
RGB.

• Bit Depth: The bit-depth drop-down menu 
determines the bit depth, either 8 or 16 bits 
per pixel.

• Resolution: The resolution drop-down menu 
determines the resolution of the file.

USING ‘EDIT IN’ FROM LIGHTROOM

For quick editing of photos Effects, select your image in 
Lightroom, go to the Photo menu and select the Edit In 
submenu and choose Effects. The editing conditions when 
using Photo > Edit in are the same as those when you use 
the File > Plug-In Extras. 

File Creation Characteristics When Using Edit In

When you use the Photo > Edit In submenu, Lightroom will ask you each time how you wish to edit the 
selected image. You have three editing options—Edit a Copy with Lightroom Adjustments, which makes a 
copy of the file that includes any edits you have made in the photo; Edit a Copy, which copies the original 
photo without any changes made in Lightroom; or Edit Original, which is not available if the photo being 
sent to ON1 Photo is a raw file.

You can also can set the file type (TIFF, Photoshop or JPEG), the color space and bit depth for the resultant 
file. 

For quick editing of photos from Lightroom, you can choose Edit 
in from Lightroom’s Photo menu.

When sending a file from Lightroom to Effects via Lightroom‘s 
Plug-In Extras menu, the edited file will be created according to 
your settings in the Plug-Ins section of Effects’ Preferences 
window.



ON1 Effects 2020 User Guide	 Part 2: Overview	 10

Using ON1 Effects 2020 with Apple® Photos
ON1 Effects 2020 integrates tightly with Apple 
Photos for MacOS and provides a seamless 
experience for enhancing your images. 

If you have Photos on your computer when you 
install ON1 Effects 2020, the appropriate plug-
in will be installed, but you will need to manually 
activate it in order to use it. To do so, go to Apple’s 
System Preferences and click on the Extensions 
icon. In the Extensions pane, click on Photos, then 
check the ON1 Effects 2020 option. This will let 
you send images from Apple Photos to Effects 
2020. (File Sharing must also be turned on in 
System Preferences for this to work.)

To edit an image in ON1 Effects 2020 follow these 
steps:

1.	 Select the image you wish to edit in Photos.

2.	 Click on the Edit button.

3.	 On the right side of the window, at the bottom of 
the editing controls, you’ll see an Extensions pop-up. 
Click that button, and choose ON1 Effects 2020.

4.	 The photo will open in Effects; make any 
adjustments you wish, and click the Done button 
in Effects to save the edited photo and return to 
Photos.

NON-DESTRUCTIVE EDITING WITH APPLE PHOTOS

When you send an image from Apple Photos to Effects, any settings you apply will be saved with 
the image, so that you can send the image back to Effects with your edits intact, as long as you do not 
subsequently edit that image inside Photos. To re-edit an image processed inside Effects, click on the image in 
Photos and follow the same three steps above. When your image is opened inside Effects, you will see all of 
the changes you made in your previous session. 

Once you make any editing changes to your image inside Photos, your Effects edits will be “baked in” to the 
image. You can send the image again to Effects, but your original settings won’t be visible. 

If you wish to keep your original Effects edits, duplicate the image inside Photos (Image > Duplicate), which 
will create a new virtual copy of the file. You can then edit one of the versions in Photos, using the other 
one to preserve your Effects edits.

After installing ON1 Effects 2020 on your Mac, you must turn the Photos 
extension on via Apple’s Extensions System Preference.

In Apple Photos, click the pop-up menu next to the 
Extensions label when editing a photo and you’ll see the 
options for sending your photo to Effects 2020.



ON1 Effects 2020 User Guide	 Part 2: Overview	 11

Extras
ON1 Effects 2020 supports a number of additional file types that can be used in various modules. These 
files are called Extras, and the file types include presets, borders, textures and look-up tables (LUTs).

ON1 includes a number of extras in the product when you install Effects, and you can create your own, or 
add extras downloaded from the ON1 website. You can use the Extras Manager to import and manage your 
own extras, creating categories for each type, and deleting extras that you no longer want.

HOW TO IMPORT EXTRAS

To import extras, choose Manage Extras from the File menu, then follow these steps:

1.	 Select the type of extras you wish to import from the list of tabs at the top (Presets, 
Borders, Textures, LUTs) You can only import extras of one type at a time.

2.	 Click on the Import button in the footer of the left column. A dialog box will appear where 
you can select the files to import. If you want to import an entire folder, open the folder, 
select the first file, then shift-click on the last file. Click Import when your selection is 
complete.

3.	 Select a category for your extras to be installed in. This is where you will be able to find it 
inside of the ON1 Effects 2020. You can select from an existing category or create a new 
one by clicking on the ‘+’ button at the bottom left side of the Extras window.

The Extras Manager lets you import presets, textures, backgrounds, borders, and look-up tables (LUTs) for use 
with the different modules in ON1 Effects 2020.
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When your extras have been imported you will see them in the Extras Manager in the category you 
selected, in the type of extra they belong to.

Organizing Presets

The Presets tab of the Extras Manager gives you additional options for working with large groups of 
presets inside Develop and Effects. When you are using the Presets tab, you’ll see ‘+’ and ‘-’ buttons, which 
let you add or delete categories to the list of your presets. 

You can also add subfolders to any of the Presets categories, which can help organize and manage large 
collections of presets. You can use drag-and-drop to move existing categories into another, or you can add 
a category subfolder to an existing category by clicking on the category and then clicking on the ‘+’ button 
in the Extras Manager window. (When you are importing presets, Effects gives you the opportunity to add 
presets to any category folder or subfolder.)

In addition to the Import option, the Presets section of the Extras Manager will also let you export presets, 
for sharing with other users, or to save seldom used presets for archiving purposes. To export a complete 
category, click on the category in the list on the left side of the window and click on the Export button. 
This will export a folder that contains a single .ONpreset file, which includes all of the presets from that 
category. If you would like to export a single preset, click on the preset from the list on the right side of the 
window and click Export.

What Type of Images Can I Import as Extras?

Textures may be any image file that Effects can open, including JPEG, TIFF, raw or Photoshop files. Border 
files must have a large central area that is transparent, so only files that support transparency, such as PNG, 
can be imported as borders. LUTs can be in either .3DL or .CUBE format.

NOTE: If you download an .ONPreset or .ONP file (for use with Effects), you 
can simply double-click on it to install it. For more information, see the Presets 
section of this guide, starting on page 33.

USING EXTRAS

You access borders, textures and LUTs from within those three filter types in Effects. To use them follow 
these steps:

1.	 Open an image into Effects.

2.	 In the Filter Options pane, select the Borders, LUTs or Textures filter type.

3.	 From the Category pop-up, select a category you have imported. User-added extras 
categories will appear at the bottom of the category list.

4.	 From the Texture, LUT or Borders pop-up in the filter, select an item from the desired 
category.
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NOTE: More information on the Borders, Textures and LUTs filters can be 
found on page 55 (Borders), page 61 (LUTs) and page 65 (Textures).

HOW TO DELETE EXTRAS

You can remove imported extras using the Extras Manager. Follow these steps:

1.	 Open the Extras Manager in any module (File > Manage Extras).

2.	 Click on the extras type that contains the content you wish to remove. This will display 
categories within that type.

3.	 To delete an entire category, select in the left column and click on the Delete button in the 
footer of the left column.

4.	 To delete individual extras, select them in the right column and click on the Delete (‘—’ in the 
Presets tab) button in the footer of the right column.

Deleting extras is permanent and cannot be undone.
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PART 2: WORKING IN EFFECTS 2020
ON1 Effects 2020’s photo-editing power consists of two distinct editing functions, separated into tabs:

• Effects is your image stylization center, with 30 filters—everything from sophisticated black 
and white conversion, HDR stylizing, glows, sharpening, color enhancement and more— that 
can be stacked in any order, all with extensive blending and masking options. 

• Local Adjustments are designed to apply basic, targeted edits to parts of your photos, letting 
you perform traditional photo-editing tasks—like dodging and burning—with ease.

To switch between the different functions, click on the appropriate tab. While you work on an image, all of 
your settings in each tab are saved while you edit. 

When using Effects as a plug-in from Lightroom Classic, or Photoshop Elements, you can still move 
between the Effects  and Local tabs, but your photos will not be re-editable once you leave Effects. If 
you’re using ON1 as a plug-in with Photoshop Smart Objects (page 7) or with Apple Photos (page 
10), your work will be re-editable.

To help you save time and create the looks that you love best, ON1 Effects 2020 also includes a robust 
preset system that lets you save settings made in the Effects or Local tabs for applying to other photos. 
Editing presets can be applied at any time are re-editable. (Presets are discussed in detail on page 33.)
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ON1 Effects 2020 Main Screen Overview

Effects provides you with an easy-to-use work space for editing your photos. Below is an overview of the 
main sections of the Effects window:

A.	Tool Well: Tools for working within Effects 2020.

B.	 Preferences/Help: Shortcuts to app preferences and help.

C.	 Filters/Preset panel: Tabbed panels with (a) a list of all installed presets (by category), or (b) a 
list of all Effects filters. 

D.	Search: Searches presets (and filters, when working in Effects) by name.

E.	 Preview Window: Displays the current photo in detail view.

F.	 Preview option toggles: Magnification slider for current image, compare (before/after) mode, 
show/hide mask, turn soft proofing and preview on or off.

G.	Tool Options bar: Options and settings for currently selected tool.

H.	Photo Information pane: Navigator, levels (histogram) and general photo information and edit 
history panel.

I.	 Effects /Local tabs: Tabs for accessing the Effects and Local Adjustments sections of the 
Effects window. Clicking on each tab brings up the settings for that tab.

J.	 Filter stack: Where you add filters to apply to your photo. To add a filter, you can click on the 
Add Filter button at the top of the stack, or use the Presets or Filters panel on the left side of 
the window.
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K.	 Reset bar: Reset All (restores settings to the original state when you opened the photos), 
Cancel (closes the photo without saving), Done (closes photo, opens a dialog box to let you 
specify the file name and type of the finished photo).

L.	 Output: Shortcuts for printing or exporting the current photo.

Effects provides several ways to navigate and view your image in the Preview window:

• By default, your image is presented in Fit view, which displays the image within the preview 
area, and the Zoom tool is selected. Clicking on the image with the Zoom tool will zoom in 
to 100%, and the cursor will change to the Hand tool. You can move around your image by 
clicking and dragging in the preview area. Clicking once will take you back to Fit view.

• You can also zoom in and out via the View menu and the Navigator pane. The Navigator pane 
displays a bounding box around the area currently on-screen, and you can reposition what is 
displayed in the preview area by clicking and dragging the box around the pane. Clicking on 
one of the buttons at the bottom of the Navigator pane will automatically zoom to Fit, 100%, 
50% or 25% views. (The buttons are visible in the Zoom tool’s Options bar.)

• When the preview zoom is larger than the viewable area, holding down the spacebar will 
display the Hand tool if any editing tool is selected. Clicking and dragging while holding the 
spacebar will reposition your image at the current view level.

Navigator, Levels, Info and History Panes
At the top of the control panel on the right of the main window are the Navigator, Histogram, Info and 
History panes. These tools can be useful for inspecting and viewing details of your image, as well as for 
looking at all of the Effects module adjustments made during a session.

THE NAVIGATOR PANE

This gives you a thumbnail view of your image. The white square 
region marks the image area that is visible in the preview pane. You 
can pan your image by clicking and dragging inside the square.

At the bottom of the Navigator pane are several zoom buttons 
representing percentage zoom views (100%, 50% and 25%). Click 
on one of the buttons to change the view. Fit zooms to fit the 
current canvas size, while 100 zooms to 100%, displaying the 
actual pixels.

THE LEVELS PANE

This gives you a color chart of the shadow, midtone and highlight 
areas based on the image RGB values (commonly known as a 
histogram). This is useful to show areas within the image that may 
be clipping. Clipping is when your image contains pure blacks or 
white and can signify loss of highlight or shadow detail.

The left side of the histogram represents the shadows, while the 
right represents the highlights. At the top of each end is a triangle. 
If the triangle is lit, there is clipping on that side of the histogram. 
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If you click on the arrows, you will activate the clipping overlay on your image, which displays the areas that 
are clipped. Those areas with a blue overlay are pure black, while the areas with the red overlay are pure 
white. You can turn the clipping view off again by clicking on one of the triangles. You can also temporarily 
enable clipping view by holding down the J key at any time. The clipping view is useful when you are 
making adjusts to the brightness and contrast of your image. (See page 42 for more information about 
using the clipping view.)

The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

THE INFO PANE

The Info pane displays metadata for the current image in an 
easy-to-read format. This metadata includes camera make and 
model; lens focal length; capture date and time; file type; GPS 
location data; ISO setting; shutter speed; aperture; and exposure 
compensation.

The Info pane also displays file-specific date, including name, color 
space, image dimensions and resolution. If any of the metadata 
fields are unavailable they will be left blank.

Settings Applied

At the bottom of the Info pane is a section that shows all of the 
operations that have been applied to the current image. Clicking 
on the right arrow to the left of the label will display a list of every 
adjustment made, including cropping, retouching, filters used, and 
and local adjustment layers. If an image has had any adjustments made to it, that section of the Settings 
Applied area will be represented in white type, and you can use the arrows to the left of the label to drill 
down further into the Effects and Local Adjustment tabs to see which adjustments were made to an image. 
(On an image that has had no adjustments, all of the settings will be grayed out.)

Double-clicking on any of the available items inside the Settings Applied area will take you to that specific 
setting inside Effects, where you can make any desired changes.

GPS Metadata

If your image has GPS metadata embedded in it, the GPS button will appear in the Info pane. Clicking on 
this button will open your default web browser to Google Maps to the location where the image was taken.

NOTE: When editing a photo in Effects via a plug-in (Lightroom Classic, 
Photoshop, Photoshop Elements, or Apple Photos), the Info pane is not visible.
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THE HISTORY PANE

ON1 Effects 2020 has a robust Undo capability, which is helpful 
when you wish to back up a few steps during the editing process. 
When you want to go back further, it can be tedious to keep 
pressing Command/Control-Z. That’s where the history pane can 
be extremely useful. It displays every adjustment made during an 
editing session. From the History pane, you can scroll through your 
edits, all the way back to the state of your photo when you opened 
it for editing.

As you work, the History pane tracks all of your edits—even when 
working with layered files—adding each change you make to the 
top of the pane. History displays not only the adjustment, but in many cases will display the settings of 
sliders in the various panes and filters. 

You can scroll through the list, and, if you click on an item, Effects will “roll back” your edits to the spot you 
clicked. You can click up and down in the list, and, as long as you don’t make any changes, the entire edit 
history is preserved. If you roll back to an edit and make a change, the History pane “resets” from that point 
on, losing any of the edits you made after the point you rolled back.

The History feature is designed to help you refine and understand the edits you made during an editing 
session; it not saved once you finish editing a photo.  

TIP: If you click on an item in the History pane, and you wish to step up or 
down in the adjustment history from that point, you can use the Undo/Redo 
commands to quickly go through the list. If you are happy with your edits, click 
back on the top item in the History pane to preserve the state of the photo.
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The Tool Well
Effects has 13 tools available for you when you are working on a photo, and are accessible via the Tool Well 
on the left side of the screen. Most of the tools are nested within one of four groups—Local, Mask, Refine, 
and Retouch—and are accessible via the Tool Options bar at the top of the screen when you click on one of 
those tool group icons. The Crop and View tools are self-contained within the tool icons (and display their 
own Tool Options bars). A description of the tools and their keyboard shortcuts follows:

• Crop Tool: Trims an image to your desired size or ratio. Shortcut key: C

• Adjustment Brush (Local group): Paints in or out local adjustments. Shortcut  
key: K

• Adjustable Gradient (Local group): Applies a selective gradient in local 
adjustment mode. Shortcut key: Shift+K

• Masking Brush (Mask group): Mask large similar areas quickly. (Includes Perfect 
Brush option.) Shortcut key: B

• Masking Bug (Mask group): Applies a selective gradient as a mask in any filter (or 
to the entire stack). Shortcut key: M

• AI Quick Mask Tool (Mask group): Create high-quality masks with only a few 
strokes as guidance. Shortcut key: W

• Refine Brush (Refine group): Lets you refine an existing mask’s edges, to help 
mask difficult areas, such as hair. Shortcut key: N

• Chisel Tool (Refine group): Removes fringes from the edge of a mask. Shortcut 
key: Shift-K

• Blur Tool (Refine group): Blurs the edges of a masked area to help it blend more 
naturally. Shortcut key: L

• Perfect Eraser (Retouch group): Removes distractions like signs and power lines.  
Shortcut key: Q

• Retouch Brush (Retouch group): Removes blemishes like dust spots and acne. 
(Includes Perfect Brush option.) Shortcut key: R

• Clone Stamp (Retouch group): Paints over an area from a sample of another 
area. Shortcut key: Shift-S

• View Tool: Adjusts the magnification of the image in the Preview area, and lets 
you move around the Preview window. Shortcut key: Z

To access a tool, simply click on the tool, or use the shortcut key attached to the tool. When selected, the 
cursor will change, and you will see a set of options for the tool in the Tool Options bar above the Preview 
window. If the selected tool is part of a tool group, you will see the other tools in that group, on the left 
side of the Tool Options bar.

NOTE: The tools in the Mask and Refine groups are only accessible once you 
have applied a filter or preset to your photo. Clicking on the Local group will 
automatically create a new local adjustment layer.
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CROP TOOL

To crop an image, select the Crop 
tool from the Tool Well. Select 
any preset crop ratio you would 
like to use from the Options bar; 

the default is Freeform, which lets you crop in 
whatever size or ratio you would like. Adjust the 
corner handles of the crop tool overlay to get 
the area you wish. (The area outside the crop 
box appears darkened for guidance.) You can 
resize and move the image inside the crop box. 
When you are satisfied with your settings, press 
the Apply button in the Options bar or press 
Enter.

To move the image inside the crop box, simply 
click and drag inside the box. You can also 
nudge the image using the arrow keys on your 
keyboard. To resize the crop box, click and drag 
on any of the handles. Clicking on a corner 
handle allows you to adjust two sides at the same time; clicking on a side handle allows you to adjust that 
side. If you hold the Shift key down while adjusting the size, the box’s proportions are maintained. To rotate 
the crop box, move outside a corner until the tool changes to rotate.

To straighten an image, you can use the Leveling Tool, which is found in the Tool Options bar when the 
Crop Tool is active. Click on it, and drag the tool across an element in your image that should be level.

NOTE: The Crop tool is disabled when you use Effects as a plug-in; you should 
use the host application to crop your photos.

Crop Tool Options Bar:

• Preset pop-up: Lets you choose from Freeform or constrained preset ratios

• Width: Sets the width of the crop box.

• Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.

• Height: Sets the height of the crop box.

• Leveling Tool: Click and drag this tool across an element in your image that should be level.

• Angle: See and adjust the angle of rotation.

• Reset: Resets the crop area to the size of your original photo.

• Apply: Applies the crop.

The Crop interface, with the Crop Preset pop-up open.
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ADJUSTMENT BRUSH (LOCAL GROUP)

The Adjustment Brush, which works within the Local Adjustments tab, works like a standard 
brush tool, with adjustable sizes, feathering and opacity. You can paint an adjustment in or 
out via the Mode pop-up in the Tool Options bar, and adjust the size and feathering of the 
brush via the bar or with the bracket keys on your keyboard. The Adjustment Brush is 

especially powerful when used with the Perfect Brush option, represented by its icon at the right of the 
Tool Options bar.

The Perfect Brush option incorporates a color-based, self-masking 
technology to help create precise selections and masks. When you 
turn the Perfect Brush option on, the Adjustment Brush collects 
the colors under the center of the brush and applies the effect 
only to those colors. This protects the adjustment from being 
applied across edges. A great of example of using the Perfect 
Brush would be if you wanted to darken the sky in an image, but 
didn’t want to darken a group of mountains on the horizon.

The Threshold slider will allow you to control the balance between 
keep and drop colors, based on the area you are working on. For 
example you may want the Perfect Brush to be very precise and 
only paint away very similar colors, other times you want it to paint away a broad range of colors in the 
same neighborhood.

The Transition slider controls the feather of the Perfect Brush based on color. To create a soft edge, 
increase the transition. To create a harder edge you need to decrease the transition.

TIP: You can toggle the Perfect Brush using Command–R (MacOS) or Control-R 
(Windows). You can also temporarily lock the color to remove by holding 
down the Command (Mac) or Control (Windows) key. This can be useful when 
brushing through areas with a lot of openings, like tree branches.

Adjustment Brush Tool Options

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the Option (Mac) or Alt (Windows) key temporarily.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

Perfect Brush options.
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• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in ON1 Effects 2020’s 
Preferences window).

• Use your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys 
on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the Option (Mac) or Alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your 
mask. While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Perfect Brush: The Perfect Brush option incorporates a color-based, self-masking technology 
to help create precise selections and masks. When you turn the option on—by clicking on the 
Perfect Brush icon in the Tool Options bar—the Masking Brush collects the colors under the 
center of the brush and applies the effect only to those colors. This protects the adjustment 
from being applied across edges, such as tree branches. 
 Further settings for the Perfect Brush can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options:

• Color Threshold: This option lets you control the balance between keep and drop 
colors, based on the area you are working on. For example, you may want the Perfect 
Brush to be very precise and only paint away very similar colors, while at other times 
you want it to paint away a broad range of colors in the same neighborhood.

• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.
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Wacom Support

ON1 Effects supports pressure-sensitive tablets from Wacom with the Adjustment Brush. When you use 
the Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both size and opacity by clicking the appropriate buttons in the drop-down menu.

Detailed information on using Local Adjustments starts on page 68.

ADJUSTABLE GRADIENT TOOL (LOCAL GROUP)

The Gradient Adjustment tool is very similar to the Masking Bug, but it is solely for use 
within the Local Adjustments tab. It lets you create a linear or radial gradient mask across 
part of your image, The gradient mask goes from dark to light in tone, applying more of the 
adjustment where the gradient is lighter, and less of the adjustment where the gradient’s 

tone is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

Adjustable Gradient Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the Gradient Adjustment 
tool (top down, bottom up, left and right, and circular vignettes), and changes the current bug 
(if there is one) to match the preset.

• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.

• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.
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Manipulating Gradient Masks

Once you’ve added a gradient to an image, you can modify it by 
accessing the parts of the gradient overlay:

• To move a gradient, click on the big circle at the center of the 
gradient and drag.

• To resize a radial gradient, click and drag on the solid line.

• To adjust the feather (hardness) of the mask, click and drag 
along the dashed line.

• To rotate the mask, click the smaller circle near the gradient 
center and drag.

Detailed information on using Local Adjustments in ON1 Effects 2020 
starts on page 68.

MASKING BRUSH (MASK GROUP)

The Masking Brush is one of two tools used for masking filters in Effects, as well as layer 
masks. When you select the Masking Brush, your cursor changes to look like two concentric 
circles, one representing the inner hard edge of the brush, and soft outer, feathered edge of 
the brush. At the center of the brush is either a plus or minus. The plus means that you are 

painting “in” a filter’s effect, while minus means the brush mode is set to paint out.

Masking Brush Tool Options

• Paint Mode: The paint mode controls if you are painting out (hiding the effect) or painting in 
(restoring the effect). You can tell your current mode by looking at the plus or minus icon in 
the center of the brush. If the icon is minus, you are painting out, and if the icon is a plus, you 
are painting in. You can change the mode in the Tool Options bar, or by pressing the X key, or 
by holding down the option (alt) key temporarily.

NOTE: If you would like to invert the mask (turn it from black to white), in 
order to paint a filter’s effect into your image, select the Masking Brush tool, 
then choose Invert Mask from the Mask menu.

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways:

• Use the Size pop-up in the Tool Options bar.

The Edges gradient shape lets you create 
such masking effects as customized, 
adjustable vignettes.
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• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ .

• Use your mouse’s scroll wheel (this option can be set in ON1 Effects 2020’s 
Preferences window).

• Use your Wacom pressure-sensitive tablet.

• Feather: You control the amount of feathering—or hardness—of the brush by using the 
Feather pop-up in the Tool Options bar. The feather has a range from 1 to 100 percent. Use a 
small feather at high magnification for precise, hard-edged work and a large, soft-edged brush 
in Fit to screen mode for general work. You can visually see your feather by watching the 
outer concentric circle of the brush tool. In addition to the Feather pop-up, you can adjust the 
size of the feather by holding down the Shift key and pressing the right or left bracket keys 
on your keyboard.

• Opacity: You can control the opacity, or strength of the brush with the Opacity pop-up in the 
Tool Options bar. The opacity has a range from 1 to 100 percent. You use a high opacity to 
paint quickly and hide large areas. You use a lower opacity for blending areas together or for 
subtle work. You can control the size of the brush several ways:

• Use the Opacity pop-up in the Tool Options bar.

• Press the option (MacOS) or alt (Windows) key on your keyboard and press one of the 
number keys. Each number represents an opacity percentage from 10% (1) to 90% (9); 
0 represents no opacity.

• Use your Wacom pressure-sensitive tablet.

TIP: Think of the opacity as the shade of gray you are painting onto your mask. 
While white in a mask represents 100% of an effect showing and black 
represents no effect showing, all opacity settings in between will show a 
percentage of the effect. This can be very useful when you wish to blend masks 
in a realistic manner.

• Perfect Brush: The Perfect Brush option incorporates a color-based, self-masking technology 
to help create precise selections and masks. When you 
turn the Perfect Brush option on—by clicking on the 
Perfect Brush icon in the Tool Options bar—the Masking 
Brush collects the colors under the center of the brush 
and applies the effect only to those colors. This protects 
the adjustment from being applied across edges, such 
as tree branches. Further settings for the Perfect Brush 
can be found by clicking on the gear icon in the Tool 
Options bar. There, you can set the following options:

• Color Threshold: This option lets you control the 
balance between keep and drop colors, based on 
the area you are working on. For example, you may want the Perfect Brush to be very 
precise and only paint away very similar colors, while at other times you want it to 
paint away a broad range of colors in the same neighborhood.

Perfect Brush options.
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• Transition: This slider controls the feather of the Perfect Brush based on color. To 
create a soft edge, increase the transition. To create a harder edge, decrease the 
transition amount.

TIP: You can toggle the Perfect Brush using Command–R (MacOS) or Control-R 
(Windows). You can also temporarily lock the color to remove by holding 
down the Command (Mac) or Control (Windows) key. This can be useful when 
brushing through areas with a lot of openings, like tree branches.

Wacom Support

Effects supports pressure-sensitive tablets from Wacom with the Masking Brush. When you use the 
Masking Brush you can enable pressure sensitive controls for the brush size, brush opacity, or both 
simultaneously. To turn this support on, click on the gear icon in the Tool Options bar. You can activate 
pressure sensitivity for both sizer and opacity by clicking the appropriate buttons in the drop-down menu.

MASKING BUG (MASK GROUP)

The Masking Bug is used for blending layers by creating radial, gradient and reflected 
gradient mask shapes quickly. It works in a similar manner to the Adjustable Gradient tool in 
the Local Adjustments pane. The mask goes from dark to light in tone, applying more of the 
adjustment where the gradient is lighter, and less of the adjustment where the gradient’s tone 

is dark. The most common use of gradient masks is to darken the sky in an image, while preserving the 
brightness of the foreground, similar to using a gradient filter on your camera lens.

To apply a standard gradient to a filter, click on the 
Masking Bug in the Tool Well, then click in the image 
roughly where you wish the gradient to go. You’ll see 
the outline of the gradient, which is called a bug. You 
can use the handles on the bug to move your gradient 
around, increase or decrease the length of the gradient, 
or rotate it.

You can change the gradient shape via the Tool Options 
bar: in addition to the standard dark-to-light horizontal 
gradient, you can also create a circular gradient and a 
reflected gradient, which is like the horizontal gradient, 
but goes from black (no effect) at the outer edges to 
white (full effect) in the center.

Masking Bug Tool Options Bar:

• Preset: The preset pop-up includes several common ways to use the tool (linear top down, 
linear bottom up, left and right, and circular vignettes), and changes the current bug (if there 
is one) to match the preset.

In this image, a Dynamic Contrast filter has been applied in Effects. 
To keep the effect out of the clouds, a Masking Bug has been added.
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• Shape: The shape pop-up controls the shape of the bug. In addition to the standard Gradient 
and the Reflected Gradient, there are two radial shapes: Center, which puts the light tones at 
the center and the dark tones on the outside of the mask, and Edges, which sets the gradient 
in the opposite direction.

• Opacity: Sets the maximum opacity or density of the mask.

• Add: Adds a new gradient using the current settings.

• Delete: Deletes the current gradient.

• Reset: Resets the mask on the layer completely. This removes all gradients and clears any 
brushing that has been done.

Manipulating a Gradient Mask

Once you’ve added a gradient to an image, you can 
modify it easily by accessing the following parts of the 
gradient overlay:

• To move a gradient, click on the large circle at 
the center of the gradient and drag.

• To resize a radial gradient, click and drag on the 
solid line.

• To adjust the feather (or hardness) of the mask, 
click and drag along the dashed line.

• To rotate the mask, click on the smaller circle 
near the center of the gradient and drag.

TIP: To see the mask created by the Masking Bug, and the range of black to 
white tonality, choose Show Mask from the View menu. You can choose either 
a red overlay, which presents the mask over your image, or grayscale, which just 
shows the mask as black to white tones.

Working with Multiple Masking Bugs

You can have up to six Masking Bugs per layer. Each bug is re-editable when you’re using Effects as a 
standalone app, or when you use Smart Object option from within Photoshop (see page 7 for more).

To add another Masking Bug, press the Add button or click outside of the current bug while the Masking 
Bug tool is selected.

Only one Masking Bug may be adjusted at a time. You will see the overlay controls for the active bug while 
your mouse is over the preview area. Inactive bugs are marked with a small circle; to select an inactive bug 
clicking on this small circle marker.

Masking Bugs are subtractive. Each bug hides more and more of the current layer. When Masking Bugs 
overlay each other they may hide more of the layer too. You can always use the Masking Brush to override 
and paint areas back in hidden by the Masking Bugs.
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AI QUICK MASK TOOL (MASK GROUP)

Powered by machine learning, the new AI Quick Mask tool can create high-quality masks with 
just a few strokes as guidance. To use it, just mark areas you want to keep in green and areas 
you want to drop in red. Then using its artificial intelligence it analyses the color, tone and 
texture of the marked regions to learn what you want to make out and then automatically 

finds the edges and creates the mask for you. Use it with layers to replace skies or with filters to selectively 
apply them quickly. Using the AI Quick Mask tool will reset any existing mask on a filter.

The first time you click on the AI Quick Mask tool, a window (called 
the HUD) will appear on-screen. This window includes instructions 
for using the tool (as described in the steps below). Once you’re 
comfortable using the Quick Mask tool, you can click on the “Do 
not show” box in the HUD to stop displaying it each time you use 
the tool.

Here are the steps you need to follow to use the AI Quick Mask Tool:

1.	 First, you need to give the tool guidance as to what you want to keep and drop. This is done 
by loosely painting over the regions in your photo. There is no need to precisely paint the 
entire photo: just a few representative strokes of red and green are all that are needed. Paint 
with Drop mode—which is the default brushing mode—over the portions of your image that 
you want to remove. These brushstrokes will appear in red. Then change the tool’s mode to 
Keep (via the Tool Options bar, or by holding the Option/Alt key) and paint over the areas 
you want to keep. These strokes will show up as green.

2.	 Now press the Apply button in either the Tool Options bar or the AI Quick Mask HUD. This 
will generate a temporary mask to preview the results (see the top of the next page). Areas 
that are filled with red will be masked out, areas in green will remain. Keep in mind the edges 
will appear rough at this point and will be smoothed out when you generate the final mask.

3.	 If the preview results look good, press the Done button in the Tool Options bar or the AI 

The AI Quick Mask tool HUD.
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Quick Mask HUD. If there are areas that are incorrect, you can continue to improve the 
results by adding more Keep and Drop strokes. Press Apply each time to preview the 
improved results. When you press Done, the edges are refined with high precision and ON1 
Effects switches to the Refine Mask tool, which you can use over difficult, semi-transparent 
areas—like tree branches—if necessary.

AI Quick Mask Tool Options Bar 

• Mode: This controls keeping (painting green) or dropping (painting red). Green areas are 
protected in your mask, and are the areas of a layer or filter that will remain. The areas 
marked in red will be removed or masked; these areas will have the filter’s effect removed.  
	 You can tell your current mode by looking at the plus or minus icon in the center of the AI 
Quick Mask brush. If the icon is minus, you are painting drop (red) areas; if the icon is a plus, 
you are painting keep (green) areas. You can change the mode in the Tool Options bar, or by 
pressing the Shift-X key, or by holding down the Option (Alt) key temporarily. 

• Brush Size: You can control the size of the brush using the Size pop-up. Use a small brush at 
high magnification for precise work, and a large brush at fit to screen for general work. You 
can control the size of the brush several ways: 

• Use the Size pop-up in the Tool Options bar. 

• Use the left and right bracket keys: ‘ [ ‘ and ‘ ] ’ . 

• Use your mouse’s scroll wheel (this option can be set in Effects’ Preferences). 

• Use your Wacom pressure-sensitive tablet. 

Further settings for the AI Quick Mask tool can be found by clicking on the gear icon in the Tool Options 
bar. There, you can set the following options (shown right): 

When you click on the Apply button, the AI Quick Mask tool will generate a temporary mask based on your brushing. 
You can refine the mask further by adding additional Keep and Drop strokes and reapplying the mask. Once you’re 
satisfied, click the Done button to have Effects generate your mask.
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• Pressure Adjusts Size: This option lets you control the size of the brush using a pressure 
sensitive tablet. The harder you press, the larger the brush becomes up to the current setting 
of the size slider.  

• Refine Edge: This applies the Refine Mask Brush 
automatically to the edge of the resulting mask, 
creating a more natural transition. This is on by 
default and recommended for most photos.

• Show HUD: This displays the AI Quick Mask HUD 
dialog (shown on page 28), which provides 
guidance on how to use the tool.

• Overlay: Sets the transparency of the red and green 
mask overlays on top of your image. A setting of 100 
displays only the mask; the default setting is 50.

REFINE BRUSH (REFINE GROUP)

This tool cleans up intricate areas and the borders along a mask, and is helpful for cleaning 
up a mask created with the Masking Brush. For example, when you wish to apply an effect to 
a subject, and there are areas such as hair, or tree branches that are difficult to remove with 
the Masking Brush.

To use the Refine Brush, select the tool in the Options bar and paint along the edges where you would like 
the mask to be refined. The brush strokes are displayed as a red overlay, and when you let up off the mouse 
button, Effects will work to make making the mask edge more defined, improving the overall mask.

Refine Brush Tool Options

• Mode: Controls the refinement mode, either Paint Out, which always refines to remove from 
the mask, Paint In, which always refines to add to the mask, or Auto, which does both at the 
same time. Paint Out is recommended in most cases.

• Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the 
intersection of the subject and background. Avoid using oversized brushes it will take longer 
to process and may yield lower quality results.

• Pressure Adjusts Size (gear icon): If you have a Wacom tablet you can control the size of the 
brush with pressure when this setting is turned on.

CHISEL MASK TOOL (REFINE GROUP)

The Chisel tool, accessible vie the Refine Tool Options, bar works to remove fringes or 
halos along the hard edges of a mask; just click and drag along the edges of a mask you wish 
to refine. Fringes are common when the background to be removed is brighter than the 
foreground. The chisel works like a chisel or plane in a wood shop: It removes just a sliver 

along the edges, and, because it only works on the edges, you don’t have to be too careful when using it.
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Chisel Mask Tool Options

• Mode: Select remove or add

• Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. 
The size of the chisel does not affect how much is chiseled off.

• Amount: Controls the amount of pixels that will be removed or added during each stroke.

TIP: Double-click on the Chisel tool icon to apply the chisel to the entire mask.

BLUR MASK TOOL (REFINE GROUP)

The Blur Mask tool softens edges of the mask where you paint; all you need to do is run the 
tool over the edges you wish to blur. Softening the edges on blurred or semi-transparent 
subjects like hair can make them blend with a new background in a more realistic manner. 

Blur Mask Tool Options

• Mode: Remove/Add/Normal lets you adjust what part of the mask edge to blur. Remove blurs 
and lightens the mask, Add blurs and darkens the mask, Normal blurs both light and darks.

• Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The 
size of the brush does not affect the blur amount.

• Amount: Controls the amount of blur. Use a low amount to maintain detail.

TIP: Double-clicking on the Blur tool icon applies the blur to the entire mask.

PERFECT ERASER (FIX GROUP)

The Perfect Eraser can be used to remove distracting elements and blemishes from your 
image. It uses a content-aware algorithm that replaces the pixels with a natural-looking result 
within the boundaries that are painted.

Using the tool is easy: paint over the area you wish to remove, making sure you cover the entire area. A 
red overlay appears where you paint. If the first attempt does not give you a perfect result, paint over it 
again and it will improve with each pass. You can also fine tune the area after applying the tool by using the 
Retouch Brush (see below).
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Perfect Eraser Options

The Perfect Eraser’s Tool Options bar consists of two options; brush size, and Wacom tablet support The 
default brush size for the Perfect Eraser is 125 pixels; you can make this bigger or smaller by clicking on 
the Brush Size in the Tool Options bar, or by pressing the right or left bracket keys on your keyboard. The 
maximum brush size is 500 pixels. If you have a Wacom pressure-sensitive tablet, select the Pressure 
Adjusts Size button in the Options bar.

RETOUCH BRUSH (FIX GROUP)

Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the 
brush on areas that contain spots or other imperfections, such as acne, sensor dust, power 
lines and more. The tool looks at the neighboring areas in your image and fills in the brushed 
area with an area of similar color and texture.

It is best to use the smallest brush size possible and to work by dabbing rather than making large brush 
strokes. If you dab with the Retouch Brush and don’t like the results, use the Undo command and try using 
a smaller brush or vary your brush stroke and try again. The Retouch Brush is also great for retouching skin.

Retouch Brush Options

• Brush Size: This adjusts the overall size of the brush.

• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: Click on the button to activate the Wacom sensitivity controls.

CLONE STAMP (FIX GROUP)

Use the Clone Stamp tool to replace an area of a photo with an area from a different part. 
Hold down Option (Mac) or Alt (Windows) and click the area you want to clone from. 
Then click and drag on the area you want to clone over and it will clone from the point you 
selected.

Clone Stamp Tool Options:

• Brush Size: This adjusts the overall size of the brush.
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• Brush Feather: This adjusts the hardness of the brush. It works best to use a feather larger 
than 50 to blend and look natural.

• Brush Opacity: This adjusts how strong the retouching is. Use 100% to completely remove an 
imperfection. Use a lower opacity to soften them.

• Pressure Adjusts Size: If you have a Wacom pressure sensitive tablet, you can adjust the size 
of the brush according to the pressure. Click the button to activate.

VIEW (ZOOM) TOOL

This tool, which is the default tool selected when you open an image in ON1 Effects, adjusts 
the magnification of the image in the Preview window. With the Zoom tool selected, click in 
the Preview window to zoom in and center the image at the location clicked. Hold down the 
Option/Alt key to display the Hand tool, which lets you pan around the magnified image. You 

can also double-click the Zoom tool in the Tool Well to set the image to 1:1 (or 100%) magnification view, 
which shows every pixel. This is best when examining small details.
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Presets
Presets are stored “recipes” that include sets of Effects filters and local adjustments, and can be applied 
to a photo with one click. Presets are a fast way to get consistent results when editing a group of images, 
helping you hone your own look. ON1 Effects also lets you create your own presets.

Three different views of the Preset panel. On the left is the List view, in the center is Thumbnail view; these views display the categories of presets. (The 
view options can be set in the View > Preset Browser submenu.) On the far right is an expanded category, displaying the various presets, with a thumbnail 
of the current image with the preset applied. From there, you can apply a preset to the current image.

As you hover over a category, the Quick View Browser icon appears on the left side of the category’s name.(as shown with the Hot Desert preset above 
left.) Clicking on that icon will open a full-screen window showing your photo with that category’s presets applied to it. (See the following page for a screen 
shot of the Quick View Browser.

Effects lets you create your own custom presets and categories, and you can also create subcategories of presets. (See “Managing Presets and categories” 
on page 37 for more.)
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ON1 Effects 2020 comes with more than 200 built-in presets, in more than a dozen categories, ranging 
from landscapes to portraits, color grading, film looks and much more. You can create your own presets, or 
import presets from other ON1 users and photographers.

Presets can also store crop settings and retouching information, as well as masks created with brush tools, 
Effects’ Masking Bug, and the Adjustable Gradient Tool in the Local Adjustments panel. If you apply a 
preset that contains these options, you should check to make sure that you have the desired result; if not, 
you can reset the various individual operations via the Settings menu. 

APPLYING PRESETS

To apply a preset to an image, click on the Presets panel. There you will see any built-in presets supplied by 
ON1—ordered by category—as well as any presets you might have created or installed yourself. Clicking on 
a category name will open it and display any presets within that category, with a tiny thumbnail showing 
your selected image with that preset applied to it. To change the size of the thumbnails in the Presets panel, 
select the Browser Mode option from the View menu and choose One, Two or Three Column View.

If you’d like to see a larger representation of what your selected photo will look like with a category’s 
presets, click on the Quick View Browser icon in the category’s 
title bar. That will display a window with all of the presets in that 
category. (Press the Escape key to close the Quick View Browser.)

To apply a preset to a photo, click on the preset in the mini-browser or in the Quick View Browser. Presets 
are not cumulative; clicking on another preset will remove the previous one and apply the new one.

Once you’ve applied a preset, you can reduce its overall effect by hovering over the preset name, which 
displays the Fade slider. This lets you lower the opacity of the Effects filters applied with the preset. 

The Quick View Browser icon is displayed on the 
left side of the Presets panel for each preset.

Clicking on the Quick View Browser icon in the Panels pane (or choosing Open Quick View Browser from the Window menu) will open a 
full-screen representation of that category’s presets, giving you a larger representation of how that preset will look on your image.
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After you have applied a preset, you can still make changes to any of the settings, add or remove 
adjustments, switch to another preset, perform retouching operations or more. 

If you don’t like a preset, clicking on another one will replace the settings of the previous preset with the 
settings of the new preset. To remove a preset entirely, choose one of the reset options from the Settings 
menu, or remove the individual settings from the appropriate panes in Effects. 

You can save a preset as a favorite by hovering over its thumbnail in the browser, and clicking on the 
heart icon. This will add that preset to a Favorites category that resides at the top of the Presets panel. To 
remove a favorite, click again on the heart icon.

Inserting Presets

When you click on a preset, Effects’ default behavior is to remove any existing adjustments and apply the 
newly chosen preset to your photo. Sometimes, however, you would 
like to add a preset on top of your adjustments. To do this, open the 
Presets pane, right-click on the preset you wish to add, and choose Insert 
Preset from the pop-up menu. This will add the preset’s filters above the 
currently selected filter pane  and will preserve any edits you made in the 
Local tab. 

Inserting a preset will only add that preset’s Effects filters to your currently edited photo. Local adjustment 
layers will not be added.

CREATING YOUR OWN PRESETS

Once you have a group of edited settings that 
you wish to save, go to the Settings menu and 
select Save Preset. The Save Preset dialog will 
appear, with options for which module’s settings 
you wish to save, naming the preset, and adding 
it to an existing or new category. Nearly all of 
ON1 Effects’ settings can be saved as a preset, 
including cropping, retouching, and masks.

If you have applied a preset to an image, and 
subsequently updated any of the edit settings 
(or add or remove adjustments), you can update 
the preset with the new settings by choosing 
Update Preset with Current Settings from the 
Settings menu. This will only change the preset 
in your app; any images that had the old version 
of the preset will keep those settings unless you 
reapply the preset. (You can also update a preset by right-clicking on the preset in the Preset Browser.) 

If you would like to create a new preset category, which will be added to the Presets panel, choose Add 
New Category from the category pop-up. 

The Save Preset window includes all of the operations possible in Effects. 
Filled circles to the left of a setting mean that the setting will be saved in the 
preset; click the circle if you don’t wish that setting to be saved.
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MANAGING PRESETS AND CATEGORIES

You can perform a variety of operations on presets and preset categories, including importing and 
exporting presets (individually or by category), deleting individual presets, and hiding categories.

Importing & Exporting Presets

You can import presets you have downloaded from the ON1 website or other source. Some files will be 
individual presets, while others might be preset “packs,” which will include more than one preset.

A preset will have an ‘.ONP’ extension, while a preset pack has an ‘ONPreset’ extension; all you need to do 
is double-click on the file—or choose Import Preset from the Settings menu—and Effects 2020 will ask you 
to pick a category where you wish to place the preset or pack, and it will copy the presets into the app. You 
can delete the downloaded files, if desired.

To export an individual preset, click on it and choose Export preset from the Settings menu. You can also 
export an entire category of presets, via the category preset menu (shown below).

Deleting presets

To remove a preset if you no longer want to have access to it, select the preset you wish to remove in the 
Preset panel, and choose Delete Preset from the Settings menu. You can also right-click on an individual 
preset and click Delete Preset from the pop-up menu.

You can delete any preset, including the presets that came pre-installed with ON1 Effects. If you think you 
might wish to save a preset, export it first, then delete it.

Managing categories

In addition to creating your own preset categories, which get 
displayed in the Presets pane, you can also perform other operations 
on categories, including deleting, renaming or exporting. These 
options are all available via the Preset Category pop-up menu, which 
is available when you hold right-click on a category name:

• To remove a category—and its presets—from the Presets panel, choose Delete Category from 
the pop-up.

• Choose Rename category if you wish to change the name of the category.

• To export a category and all of the presets within it as an ONPreset pack, choose Export 
Category from the pop-up menu.

TIP: Many preset management options can also be performed by clicking on a 
preset in the Preset panel and right-clicking on the preset. This is helpful if you 
want to update, export or rename a preset without applying it to an image in 
Effects.

Right-click on a preset category to get the 
category pop-up menu.
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Nesting presets

To help manage large groups of presets, Effects’ Extras Manager lets you nest preset categories. See page 
11 for details on how to create and manage preset category subfolders.

RESETTING EDITS

Any edits you have made with ON1 Effects 2020 can be completely reset while you’re working. The 
Settings menu offers five options for erasing edits made to a photo:

• Reset All Settings: This removes all adjustments made to a photo in Effects. (This option can 
also be accessed from the Reset All button at the bottom right of the Effects window.) 

• Reset Effects Settings: Removes only the settings applied in the Effects tab.

• Reset All Retouching Tools: Resets any retouching applied to the photo.

• Reset Local Adjustments: Removes all local adjustment layers.

• Reset Crop: Returns the image to its original, uncropped size.

You can undo any of these changes immediately after making them; otherwise resetting with the 
appropriate option will permanently reset the image.
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Soft Proofing
ON1 Effects’ soft proofing feature lets you see 
how a photo will look when printed, using the 
color profiles that get installed with your printer. 
Soft proofing helps you determine where there 
might be issues when you print, so that you can 
adjust your tone, color and effects to give you a 
print that is closer to your editing vision.

Normally, when you’re viewing an image in 
Effects, you are viewing it through the lens 
of your monitor’s display profile. The color 
gamut of your computer’s display is wider than 
that of most photo printers, which means that 
some colors you are able to view on-screen 
are not reproducible when you print. When 
this happens, the color profile conversion 
that happens in the print engine will cause 
substitutions of colors that the printer cannot 
print to the closest color that it can. This means 
that your image could have subtle (or broad) 
shifts in color, especially in certain color ranges.

Soft proofing is turned on via the View menu, or 
by clicking on the soft proofing icon to the left 
of the Preview button at the bottom of the main 
Effects window. You soft-proof various paper 
types by choosing an installed printer profile 
from the Profiles submenu. The image will 
change to approximate the color of the paper 
you’re profiling. You can also turn on an overlay 
that will display out-of-gamut colors.

The primary soft-proofing options are available 
underneath the Enable Soft Proofing item in the 
View menu. The options are as follows:

• Gamut warning: When checked, this 
displays colors in the image (via a 
red overlay) that don’t correspond to 
the current printer profile being soft 
proofed.

• Profiles: The Profiles submenu lists 
the currently available printer profiles. 
Choosing one will change the on-screen display to use that profile. You can also import 
profiles via this submenu.

These three screen shots show the results of soft proofing options. The top 
image is with soft proofing off (and is using the display color profile). The 
middle image is with soft proofing turned on, and using a printer profile for 
Epson’s Hot Press Bright paper. The bottom image has the Gamut warning 
turned on; out of gamut colors are highlighted by the bright red overlay.
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• Intent: Effects offers two different rendering “intents” when soft proofing, which are used to 
convert the color from display to print. Perceptual shrinks the color gamut during the 
conversion, which works to preserve the relationship between colors in the image. The other 
intent type, Relative, only converts colors that are outside the current color gamut, but this 
can sometimes cause two colors, one in gamut, and one outside, to be identical after 
conversion.  
	 Neither rendering intent is perfect or desired; it often is a 
matter of the makeup of the image, your editing intent, the 
paper being printed on, and so forth. Often, you’ll want to 
switch back and forth between Relative and Perceptual, 
seeing which gives you a better print.

• Simulate Paper and Ink: Turning this setting on will cause 
Effects to use the white point for the chosen paper type 
(instead of the white point of your monitor), and the paper’s 
actual black density (instead of the display’s black point). 
If you’re trying to match a print, you will usually want this 
setting turned on.

Adjusting images with soft proofing is often a bit of trial and error. 
It’s easy to get caught up in eliminating out-of-gamut colors, but most 
modern photo printers—both home printers and online print services—
do a pretty good job of properly approximating colors. 

The biggest thing you want to be looking for when viewing a soft 
proof is tone, contrast and color accuracy between screen and print. 
When using a home printer, use test prints to hone in on the right mix 
of Effects adjustments. (See page 72 for information on printing 
photos from within Effects.)

Other Preview Options
In addition to soft proofing, ON1 Effects 2020 
offers a few other previewing options, which 
can be found Preview Option section at the 
bottom of the main window. With these options, 
you can compare the before and after views of a 
photo—in either split-screen or full-screen views—see the current mask, and turn soft proofing on or off. 

CHANGING THE MAGNIFICATION VIEW 

Effects includes various options for zooming in or out of a photo while you’re working on it. In addition to 
the Zoom tool and the Navigation pane (see page 33 and page 16, respectively), you can change the 
zoom view by moving the magnification slider. You can either click on the control and slide it to the right to 
zoom in and to the left to zoom out, or you can click on the boxes at the ends of the slider.

The Profiles submenu displays the installed 
printer profiles for any installed photo 
printer. You can also import your own color 
profiles.

The Preview area at the bottom of the main Effects window includes options 
for adjusting the preview magnification, turning compare (before/after) view 
on or off, viewing the current mask, turning soft proofing on or off, and for 
viewing the original photo, with all edits removed.
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BEFORE/AFTER PREVIEWS

As you work in Effects, it can be helpful to see how individual edits—via items in the different edit tabs—
affect your photo, as well as to see the cumulative changes made to the original image. The Compare mode 
displays a side-by-side view of your photo, with the original version on the left, the edited version on the 
right. There is a movable slider in the middle of the screen, which lets you view more or less of each view; 
click on the box at the center of the slider and drag it to the left (to view more of the edited image) or to the 
right (to view more of the original. While working in Compare view, you can use the magnification slider to 
zoom in or out of the image, which can be useful when you wish to see the effects of your edits on smaller 
sections of your photo.

You can also view your original image full-screen by clicking the Preview button at the far right of the 
previewing toolbar. When you click this button, the original photo is displayed with a “Preview Off” overlay. 
To return to your edited version, click the Preview button again. (You can also use the backslash key—‘\’—to 
show and hide the full-screen preview.)

SHOW/HIDE MASK

ON1 Effects 2020 has extensive masking capabilities throughout Effects. While you’re in the process of 
creating a mask, you have two options for displaying the contents of a current mask: 

• As a transparent red overlay, where the masked sections of your photo are shown in red.

• As a grayscale mask, where you do not see the photo, but see only the mask. Masked areas 
are shown in shades of gray, with pure black meaning that those pixels are completely 
masked. Gray values (from 1% to 99%) represent the opacity of the those pixels relative to 
the mask, and areas of pure white are not masked.

Effects’ Compare view displays a before/after view of your current photo, with a movable slider (circled, above) for expanding and contracting the 
different views.
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The overlays can be set in the Mask menu’s View Mode submenu while you are working in Effects. You can 
also, via this option, show the mask as a red overlay only when you are brushing a mask. 

You can toggle the current mask view by clicking on the Show Mask icon in the previewing toolbar, or by 
pressing the O key.

For more information on the varying aspects of masking in ON1 Effects 2020, check the respective 
masking tools earlier in this chapter, as well as the “Filter Masks” on page 48.

FOCUS AND CLIPPING VIEWS

Two additional—and powerful—previewing tools are available when you are editing photos: the Clipping and 
Focus Mask overlays. 

Clipping

Clipping occurs when the shadow and highlight tones in an 
image are suddenly cut off to completely white or black, 
rather than fading smoothly. (Large expanses of white pixels 
in a photo are often referred as ‘blown’ highlights, and can be 
quite distracting to a viewer.) One of the benefits of shooting 
in raw format is that, while many photos will have areas of 
pure white or black when originally viewed on-screen, there 
is still recoverable data in the raw image. The Clipping overlay 
can help determine how big a problem you might have with a 
photo, and how easy (or difficult) it will be to fix. 

To display the Clipping overlay temporarily, press the J key; 
to turn it on permanently as you move from photo to photo, 
choose View > Show Clipping, or press Alt (Windows) or 
Option (Mac) J on your keyboard.

The Clipping view overlay displays the areas that have either pure white or pure black in them. Those areas 
with a bright blue overlay indicate pure black pixels, while the areas with the bright red overlay indicate 
pure white pixels.

The two options for viewing a mask are with a red overlay (left), which shows the masked areas in red, and a grayscale mask (right), which shows only the mask, in a 
range of tones from white (not masked) to black (completely masked). Tones in gray represent varying percentages of the mask’s opacity.

Clipping view displays pure white pixels with a bright red 
overlay, and pure black pixels with a bright blue overlay.
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Focus Mask

It can often be difficult to view the sharpness in a photo 
without zooming in to 100% or more, and if you have a 
lot of photos from a shoot, it can be a bit tedious to check 
focus at that level. Luckily, Effects’ Focus Mask overlay can 
help winnow your shots down to the sharpest ones.

To turn on Focus Mask, choose View > Show Focus Mask, 
or press Shift-Alt-J (Windows) or Shift-Option-J (Mac). The 
sharpest areas in your image will be represented by a bright 
green overlay. As you move from photo to photo in a folder, 
you’ll be able to tell whether you have an acceptable level of 
sharpness where you need it by the strength of the overlay. 
The mask will continue to be displayed even as you zoom in 
on a photo.

SHOWING OR HIDING FILTER AND LOCAL ADJUSTMENTS PANES

All of the individual filter panes and local 
adjustment panes inside Effects have a Show/Hide 
control in the upper left-hand corner of the panel. 
You can make your adjustments, and can click the 
control to turn the effect on or off. 

This option is not solely for previewing an effect; if 
the adjustment is turned off, it will not be present 
in the finished, edited image. This can be helpful if 
you’re trying different filters in Effects, for example, and you want to see if one looks better than another, 
or if you wish to see if it truly helps the photo or not. To turn the adjustment back on, click on the Show/
Hide control so that the circle is filled.

If you wish to view your photo without those adjustments, you need to press the Reset icon, which is 
represented by ‘⟲’ at the top right side of the panel. 

For a complete description of the controls in the filter panels, see page 45.

The Focus Mask option displays areas of sharpness with a 
bright green overlay.

To turn an effect or other adjustment off, click on the Show/Hide control 
in the upper left of an adjustment’s panel. If the control’s circle is empty, 
that effect is not implemented. Clicking the control will turn it back on.
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Working with Filters

With 30 different adjustment types—called filters in Effects—you can create stunning, pro-level photos 
with ease. Effects is extensively customizable in how filters are applied, and, when working with an image, 
you can:

• Add filters in any order;

• Have multiple instances of any filter;

• Move filters up and down in the stack;

• Add blending mode options to all or some of the filters and set the opacity of each filter 
individually; and

• Create complex masks for each filter, letting you selectively apply a filter to specific portions 
of an image.

Filters are the building blocks of Effects’ editing power. Each filter acts like a movable, editable layer over 
the base image you are working on. You can use Effects’ masking tools to apply a filter to only part of an 
image and can change the blending mode (and opacity of the filter) to alter the way the filter interacts with 
those above and below it in the stack.

The Effects tab has 30 filter types, added either by the Add Filter button found at the top of the Effects 
tab, or via the Filters pane on the left side of the window. You can apply filters in any order, and you can 
have more than one instance of a filter in the stack. (This can be helpful when you are creating complicated 
masks on an image and wish to apply the same filter differently in parts of the photo.)
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FILTER OVERVIEW

Each filter pane has a different set of adjustment 
options and controls, but every filter pane has the 
same five sections:

A.	Filter on/off button (left); Show/Hide 
Mask (right)

B.	 Displays blending mode options (left); 
Resets filter (middle); Deletes filter from 
the stack (right).

C.	 Filter opacity setting.

D.	Styles pane for filter presets.

E.	 Control area for adjusting that filter’s 
specific settings (dependent upon the 
filter chosen).

APPLYING FILTERS WITH THE ADD FILTER BUTTON

If you click the Add Filter button at the 
top of the Effects tab, the Filters window 
opens up, with a list of all 30 filters. If 
you run your cursor over a filter name, 
the right side of the window will have 
a small before/after thumbnail, a short 
description, and a list of keywords that 
relate to that filter. To add a filter, click 
once on the filter name, and it will add it 
to the stack, above the current filter. If 
there aren’t any filters in the stack, the 
new filter will be at the top of the stack. 
You can click and drag the title bar in any 
filter to move it up or down in the stack.

If you’re not sure what you might looking for, you can search for filters using keywords, like “monochrome,” 
“contrast,” “sharpening,” and so forth. Effects will then narrow down the search to those filters that match 
your search terms.

Overview of a filter—in this case, the Cross Process filter—inside Effects.

The Filters window opens when you click on the Add Filter button at the top of the 
Effects tab.
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APPLYING FILTERS WITH THE FILTER BROWSER

In addition to the Presets panel, Effects has an 
additional Filter panel on the left side of the 
screen. This panel lets you browse all of the 
filters inside Effects, and display previews of the 
available styles for that filter. 

To choose the Filters panel, click on the Filters 
tab. A list of the filters will appear, and clicking 
on a filter will display thumbnails of your image 
with that filter’s available styles. To choose one, 
click on the style, and Effects will add that filter 
to the Overall Settings pane. This will replace 
the currently selected filter in the stack; to add a 
new one on top of the stack, click the Add Filter 
button at the top of the Effects tab on the right 
panel, then choose a filter from the list. (You can 
also click and drag the title bar of any filter and 
move it up or down in the stack.)

If you’d like to see a larger representation of 
what your selected photo will look like with a 
filter’s styles, click on the Quick View Browser 
icon in the category’s title bar. That will display 
a window with all of the styles in that category 
(see page 35). Press the Escape key to close 
the Quick View Browser.

To change the size of the thumbnails in the filter 
styles panel, select the Browser Mode option 
from the View menu and choose One, Two or 
Three Column Thumbnail View. (If you choose 
Thumbnail from the Browser Mode submenu, 
the Filters and Presets panels will display as 
thumbnails.)

If you’d like help with what the different filter 
operations do, click on the Info button at the top 
right of the panel. With that button checked, 
when you hover over a filter, Effects will display a small pop-up window containing the same description 
(with before/after thumbnail) found in the Add Filter window. Click the Info button again to turn off this 
display.

Searching for filter styles inside the Filter Browser

To search for styles inside the Filter Browser, type in the name you’re looking for in the search field at the 
bottom of the panel. The search results will appear in a new sub-folder called search results, which will be 
selected automatically.

The Filter Browser has a list of all the filters available in Effects (left). Clicking 
on a filter will display thumbnails of the filter’s styles using your photo (right). 
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Saving filter styles as favorites

If you hover over a filter style’s thumbnail in either the Filter Browser or the Quick View Browser, you’ll 
see a heart icon. Clicking the icon will fill the heart in and add that style to your Favorites category. This 
category resides at the top of the filter list, and contains all filter styles you have selected as a favorite. To 
remove a favorite, open the Favorites category, and click again in the heart icon. To apply a filter style to a 
photo, simply click on the style in either the Filter Browser or in the Quick View Browser.

Filter pane details
By default, the filter stack is empty, although, if you have applied a preset that uses filters from Effects, you 
will see those filters in the stack. Clicking on the button in the top left corner of the filter pane will turn 
that effect on or off, which can be helpful if you want to see the effect in the context of other edits you 
have made. If you don’t like the effect, click on the ‘X’ icon in the pane’s title bar to get rid of it. The Reset 
button, which is next to the Delete button, represented by ‘⟲,’ will reset that pane’s settings.

To move a filter up or down in the stack, click on the pane’s title bar and drag it up or down. A heavy white 
line will appear between panes as you drag; let go of the mouse at the location you wish the filter to go.

TIP: Each pane can be collapsed, by clicking in the pane’s title bar (a Hide/
Show link is visible when you move your cursor over the title bar, but the entire 
title bar is clickable). If you don’t want to scroll up and down the filter stack 
with a lot of open panes, go to the Window menu and choose Solo Mode. This 
will leave the current pane open, and will hide all the other panes. Clicking on 
another pane will open that one and collapse the previous one.

STYLES

As noted in the section on the Filter Browser (page 
46), all Effects filters have a set of built-in styles, and 
when you add a filter to the stack, you’ll see the Styles 
section in the top part of the pane. Styles are like preset 
adjustments for a pane: they provide a group of settings 
to help you get started in the pane, or to apply a specific 
effect.

You use a style by clicking on the style’s icon in the pane, and then can adjust 
the sliders as desired to get the right effect for your photo.

You can also save your own settings as a style. Simply click on the More icon 
on the far right side of the styles list for that pane, then choose Save New 
Style from the pop-up. Name your style, and it will then be added to the top 
of the More menu (see right). To apply a saved style, choose the style from the 
More pop-up menu. To adjust the settings for a saved style, apply it, make any 
changes you would like to the sliders or other options, then right-click on the 
More pop-up and choose Update Style with Current Settings from the menu.

Styles for the Split Tone filter.

Saved styles appear at the top of 
the More menu.
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FILTER MASKS

Every filter (and local adjustment) has a mask associated with it, which lets you apply that filter’s effect to 
specific areas of an image, using the Masking Brush (or the Local Adjustment Brush and Gradient, when 
working in the Local tab) and Masking Bug tools. By default, the mask is white, which means that the effect 
is visible in every part of the image. Using the Masking Brush, for example, you can ‘paint out’ the effect in 
areas that you wish not to be affected by the filter. Alternatively, you can invert a filter’s mask and choose 
to ‘paint in’ the filter where you would like it to be.

When you add a filter, the mask is technically hidden. You can add one by either selecting and using one of 
the two masking tools, or by clicking the Show/Hide Mask icon in the title bar of the filter pane (this icon 
will initially be represented with a plus sign in the middle of it). When you add a mask in either way, the 
contents of the Show Mask icon will represent the mask on that filter layer.

Effects has two options for viewing the contents of a mask: either as a red overlay on top of your image 
(the default) or a view only of the mask itself, represented as grayscale. These options are available from 
the Mask menu; select Show Mask to see the mask, while the View Mode option lets you switch between 
the two modes. (Effects will remember the previous settings.)

The Mask section of any effect or local adjustment has the following contents, as shown below (using the 
Dynamic Contrast filter as an example):

A.	The Show/Hide Mask icon, which displays the 
contents of the current mask. The default mask 
contents are white when you add an effect, and 
black when you add a local adjustment layer.

B.	 Sets the overall opacity of the mask.

C.	 Larger display of the current mask, with buttons 
to invert, reset, copy, paste, and view/hide the 
mask contents. The Lumen button creates a 
luminosity mask of the image.

D.	Density adjusts the overall mask density from 
black (100) to white (0). Feather blurs the mask.

E.	 The Levels and Window settings let you adjust 
the black and white points of the mask, fine 
tuning them in different ways.

F.	 The Color Range option lets you choose a color 
(selected via the dropper tool), and make or tune 
the mask based on the range of the color selected.

Overview of the Mask Options section of a filter pane in Effects, 
showing a luminosity mask. Mask Options is also applicable 
when working in the Local Adjustments tab, or on a layer in the 
Layers pane.
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Luminosity Masks

A luminosity mask is a specialized mask type you can create anywhere you can create a mask inside Effects. 
This mask uses the brightness (or luminance) values in your image to let you target specific tonal ranges 
with an effect (or to hide the effect from those tones). It is ideal for subtle enhancements to very specific 
areas of an image.

To add one of these masks, click on the Lumen button in the Mask options area or choose Create 
Luminosity Mask from the Mask menu. If you view the mask, you will see that it looks like a black-and-
white version of your image. With a luminosity mask, your effect will be applied in an increasing amount 
depending upon the brightness value of the pixel underneath: if the pixel is black, none of the effect will be 
applied; if it is white, it will be entirely applied; for all other tones, the effect will get applied as a percentage 
of the pixel’s brightness, from 0 (white) to 100 (black).

You can use the Levels or Window controls to further target tones with your luminosity mask. The Levels 
setting lets you set the black (left triangle) and white (right) points of the mask, with the midpoint, or 
gamma, setting being adjusted by the middle triangle. This lets you refine the mask to focus on narrow 
bands of luminance values in an image; for example, if you wanted to focus an effect on the midtones, 
bringing the white and black points into the middle of the Levels slider, and adjusting the midpoint, will help 
achieve this much quicker than you could with the Masking Brush.

The Window slider is similar to the Levels slider, in that it works like a black point slider from both sides. 
When you move the right and left triangles, all of the tonal ranges outside the points will be black, leaving 
those areas affected that are within the ‘window’ of the mask. For example, if you wanted only the shadows 
in your image to have an effect, you would move the right slider over towards the left by about two-thirds.

A photo with the luminosity mask displayed in Grayscale mode (set using the settings from the Mask menu’s View Mask 
option), with adjustments to the Levels and Window controls to mask the sky for the effect  Viewing the mask can help 
greatly when refining a luminosity mask via the Density, Feather, Levels and Window controls.
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Color Range selections

The Color Range option lets you create a mask using a specific color, either one inside your image, or one 
via your system’s color picker. To use this option, click the On button next to the Color Range section, and 
click the eyedropper tool to select a color inside your image that you wish to sample. You can then use the 
slider to expand or contract your mask based on that color: lower numbers means that fewer colors will be 
selected, higher numbers mean that more.

Masking tips

Here are a few tips for working with the various options in the Mask pane:

• You can use multiple masking tools to create and modify masks. For example, you can start 
with a luminosity mask, adjust the tonal range of the mask with the Levels or Window sliders, 
and then further refine your mask with the Masking Brush or Masking Bug. A luminosity mask 
always overrides the current mask, however, so you should start there.

• Use the Feather slider to smooth transitions between masked and unmasked sections.

• Lowering the Density slider helps intensify an effect after you’ve created a mask. Think of it 
like a ‘reverse fade’: at the 100, all of your mask is viewable, at 0, the mask is entirely white.

• Because it can sometimes be helpful to use the same mask on different filters, use the Copy 
button to grab the contents of a mask from one filter and the Paste button to paste that onto 
the mask of another filter.

DELETING A FILTER

You can remove a filter by selecting it and pressing the ‘X’ icon to the right of the filter’s pane.

FILTER OPACITY

Every filter has an opacity setting, which effectively adjusts the strength of the filter. The Opacity slider, 
which is found at the top of each filter’s pane, ranges from 0 (no effect) to 100 (full effect). What this 
means is that at 100, all of the filter is applied to the image in the stack. At 50, the filter strength is half, and 
the effect is much less strong. Playing with a filter’s opacity can often help soften an effect in a way that 
you wouldn’t be able to get otherwise.

For example, if you add a Black & White filter, but would like a faded, muted color effect, simply reduce the 
opacity of that filter. The more you reduce the opacity, the less effect the Black & White will have.

By default, when you add a filter, the opacity will be set to 100. You can create presets, however, with 
whatever opacity you wish for a given filter.

BLENDING MODES

In addition to opacity, you have one other very powerful option for adjusting the strength and effect of a 
filter: blending modes. Blend modes determine how a filter interacts with the filters below it in the image 
stack. Blend modes can darken or lighten an image, depending upon the mode chosen, while others adjust 
contrast or color. ON1 Effects 2020’s blend modes also let you apply a blend mode to specific colors or 
tones in your image, making them a very useful tool for precision editing of your images. You can apply 
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sharpening, for example, only to the midtones in an image, which can be very helpful in a landscape image.

To see the blending modes, click on the Blending Options gear icon at the top of a filter’s pane. The 
Blending Options area will drop down from the top of the panel. The blending option controls are:

• Blending Options: A pop-up list of blending modes. There are 24 common blending modes 
available in the list, including Normal, Lighten, Darken, Screen, Multiply, Soft Light, Hard 
Light, Overlay and Color.

• Apply To: This lets you apply the blending mode to a specific color or tonal range. The 
options are; All (the default), Highlights, Midtones, Shadows, Reds, Greens, Blues, Magentas, 
Cyans, Yellows, Flesh Colors, Vivid Colors and Neutrals. (You can also manually choose a 
color range by selecting the Dropper Tool in the pane and clicking on a color in your image.)

When you choose one of the options in this menu, the adjustment is only applied to that part of the image 
that is based on the lightness, hue, or saturation range specified. The Range slider expands or contracts the 
selected option, and the Highlights, Shadows, and Skin sliders protect those settings from your 
adjustments.

How blending modes work

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Effects 
2020, it might be difficult to know which ones 
to use in any given situation, but they can easily 
be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 
Most often, when you know how you want to 
apply an effect —by darkening, for example—
you’ll need to perform a bit of experimentation 
with the different modes in that category to determine which mode works best.

MASTER OPACITY, BLENDING AND MASK OPTIONS

Effects also has master opacity and master blend mode options for the entire image stack, and includes a 
Master mask option. The Master Opacity slider, found at the top of the Effects tab, controls the strength of 
the composite filter stack against the original image.

The Master Blend Mode options can be accessed via the gear icon at the top of the Effects tab. It has the 
same controls as the blending options in the individual filter panes.
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To create a Master mask, click on the mask icon next to the Save Preset icon in the Effects tab. This mask 
works on the entire effects stack, letting you selectively add or remove an entire effect.

Effects 2020 Filter Types
Effects has 30 filter types available for you to use inside ON1 Effects 2020. Each filter has a set of styles in 
the top row, providing a range of popular or useful options for using that filter. You can also save your own 
preset styles by clicking the More pop-up at the end of the Styles row.

ANTIQUE

The Antique filter gives your image an aged look; unlike the 
Vintage filter, this filter focuses more on a monochromatic or hand 
colored look.

• Color: Displays a list of color options that are similar in 
tone to the Split Tone filter, providing a duotone-style 
effect.

• Brightness: Adjusts the overall brightness of the image.

• Fade: Adds a white fill to the image, giving the illusion of 
a faded photograph.

• Saturation: Adjusts the color saturation. Moving the slider to the left decreases the 
saturation; moving it to the right increases it.

• Film Grain: Amount controls the strength and size dictates how large the grain appears.
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BLACK & WHITE

This pane is used to turn a color image into a monochromatic 
image, with some additional toning features to help you achieve a 
wide range of black-and-white styling options.

The styles at the top of the pane represent different filter types 
often applied to an image, while the Auto button selects the black 
and white points of your image automatically. To manipulate the 
tones manually, move the color range sliders to the right (increasing 
brightness) or the left (decreasing). Alternatively, you can choose 
the Channel Mixer option from the Conversion pop-up, and use 
the slider to choose a look that accentuates the color tones you are 
most interested in.

To change the tones directly, click the Color Response tool in the 
left of the pane and click and drag in the image to increase or 
decrease the brightness of the selected color range.

Tone

The Tone section of the Black & White pane is similar to the one 
in the Tone Enhancer filter: it lets you adjust brightness, contrast, 
highlights and shadows, whites and blacks, and detail, directly 
within the filter pane.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Compression: Compresses the tone to reveal highlight and shadow detail.

• Detail: Increases the local contrast in the image.

Toner

The Toner section of the filter is designed to approximate many traditional and popular darkroom-based 
paper toners, from sepia tones to platinum, selenium, coffee and more. You can choose from more than 20 
toning options via the Type pop – up menu, and adjust the combination of paper (which is represented by 
the Highlights section of the pane) and silver (represented by the Shadows). To tune your options, you can 
adjust the Hue or Amount of each setting, and use the Swap tones icon (next to the Highlights color well) to 
swap the highlights and shadows colors. The Preserve Whites and Blacks button keeps the pure whites and 
pure blacks neutral, instead of taking on the color of the toner.
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Film Grain

The last section of the Black & White pane is Film Grain, which, like the Toner section, is designed to add 
a classic film grain look to your photos. To add film grain, choose from the drop-down list of popular black 
and white films. The Amount slider controls the strength of the effect, while the Size slider adjusts the 
scale of the grain.

BLEACH BYPASS

This filter is based upon an old color film processing technique 
where the bleaching step was skipped. It reduces the saturation 
and increases the contrast.

• Amount: Controls the strength or amount of the bleach 
bypass appearance.

• Brightness: Adjusts the overall brightness of the image.

• Contrast: Increases or decreases the global contrast.

• Detail: Enhances the details by increasing the micro 
contrast.

• Saturation: Adjusts the underlying saturation.

• Tint: Choose a new color by clicking in the color icon or by using the Hue slider.

• Amount: Adjusts the strength of the tint.

BLUR

This filter has five options for adding blur to your images: Gaussian, 
Motion, Radial, Surface and Box. Each blur has its own look:

• Gaussian: This is a simple Gaussian blur applied to your 
image. It has one slider, Amount, which controls the 
strength of the blur by adjusting the radius.

• Motion: A motion blur adds the appearance of 
movement.

• The Amount slider controls the strength of the blur, and Distance controls the blur 
relative to area between the subject and camera. Angle sets the angle of the blur, 
while the Smoothing slider softens the lines created by the motion.

• Radial: These blurs are circular, zooming out from a central point.

• Amount controls the strength of the blur. Quality controls how noisy the blur is, with 1 
being grainy and 100 smooth. Smoothing softens the lines created by the motion.

• The Radial blur type includes a center spot selector at the bottom of the pane. Click on 
the icon, then click on the part of the image you want to make the center of the blur.

• Surface: These blurs tend to maintain edges but add blur to the details. This blur type can 
give you a “simplified” effect. The Amount slider controls the strength of the blur, while 
Threshold sets how similar colors are grouped.
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• Box: A Box blur is similar in concept to a Gaussian blur, but it bases the blur on contrasting 
edges. Box blurs tend to retain edges a bit more clearly than Gaussian blurs.

NOTE: Do not use the Opacity slider when trying to reduce the strength of a 
blur; use the Amount sliders instead.

BORDERS

ON1 Effects 2020 has a large collection of pre-made borders and 
edges that you can add to your photos. These borders range from 
classic film borders to viewfinders to artistic effects to emulsion 
transfers and many more.

The Borders filter also has an extensive set of controls for 
manipulating the size, color, and blending mode of the borders you 
choose.

You can also import your own borders, either directly into the 
Borders filter pane, or via the Extras Manager (see page 11). 
Border files need to be a standard PNG file type with a large 
central transparent area

The Category and Border pop-ups at the top of the pane are used 
to select the border category and the specific borders within each 
category. There are 8 built-in categories, sorted by type. Any user-
imported borders will also appear in this list.

Once you have chosen a border to add, you can adjust its blending 
mode and opacity, and, if the border has color, you can adjust its 
hue, saturation and brightness. Alternatively, if the border is black or white, you can colorize it.

The Transform section at the bottom of the Borders pane lets you scale the border up or down in size, to 
help you get the look you’re after, and the Fit Image slider adjusts the size of the image under the border.

You can rotate or flip the currently selected border by clicking the buttons at the bottom of the screen.

NOTE: See “Extras” on page 11 for information on how to use the Extras 
Manager to import borders, textures and other extras, along with additional 
information for preparing files for the Borders and Textures filters.
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CHANNEL MIXER

The Channel Mixer filter adjusts the intensity and color of the 
individual red, green and blue channels in a photo. You can use it 
for black and white conversions, channel swapping for infrared 
shots, or to shift entire color ranges.

Click on the channel icons to select a specific channel, and use 
the Red, Green and Blue sliders to increase or decrease the pixel 
values for that channel. The Constant slider affects the luminosity 
of the currently selected channel. 

COLOR ADJUSTMENT

This pane lets you adjust specific ranges of color in your photos. 
The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky).

In the pane underneath are color swatches for eight colors: red, 
orange, yellow, green, aqua, blue, purple and magenta. Clicking 
on one of the colors will let you adjust the hue, saturation and 
brightness of the selected color range. Other settings include:

• Range: This slider lets you narrow or widen the range of 
the selected color.

• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to adjust the hue, saturation or brightness dynamically. 
To do this, click on the tool and choose which parameter you would like to adjust. Then click in your image 
on a color you would like to adjust and drag the cursor to the left or right to decrease or increase the effect.

COLOR BALANCE

This filter lets you adjust the colors in a photo’s highlights, 
midtones and shadows tones. This can be useful when you wish 
to color grade a photo, remove color casts from shadows or 
highlights, or to create duotone- or tritone-style images.

To use the pane, click on the tone you wish to adjust (Highlights, 
Midtones, Shadows) and raise the Amount slider. After that, use 
the Hue and Brightness controls to adjust the look you wish to 
achieve. The Color patch, which will originally be represented as 
18% gray, will change to represent the combination of all three 
sliders for that tone.
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COLOR ENHANCER

The Color Enhancer is designed to give you complete control over 
color manipulation in your image, whether it is on a globally across 
your entire image, or by adjusting different color ranges. 

The styles at the top of the pane are designed to help enhance 
specific scene types (Foliage, Fall, Desert, Sky). To adjust global 
color in an image, work in the Color section of the top half of the 
filter pane; to work with individual color ranges, use the Color 
Range section at the bottom of the pane.

Color

The Color sliders in the top half of the pane control Temperature, 
Tint and Vibrance. They are used to remove a color cast and 
enhance the color of the image. The settings in this section of the 
Color Enhancer pane include:

• Auto Button: The auto button attempts to detect 
and remove a color cast. It makes adjustments to the 
Temperature and Tint sliders.

• Gray Dropper: Used to remove a color cast of an image. 
Click the icon to activate, then click on an area in the image that should be gray. The sliders 
will automatically adjust according to the sample you have selected.

• White Balance: This pop-up lets you change the white balance according to common color 
temperatures (As Shot, Auto, Daylight, Cloudy, Shade, Tungsten, Florescent, Flash, Custom). 
The default is As Shot, the color temperature that the camera recorded when you took the 
photo.

• Temperature: This slider shifts the color either cooler (blue) or warmer (yellow).

• Tint: Shifts the color either green or magenta.

• Saturation: Increases or decreases the saturation of your image.

• Vibrance: Increases or decreases the color of muted tones, leaving more saturated colors 
alone.

• Reduce Vibrance on Skin: When turned on, adjustments made with Vibrance slider are 
reduced on skin colored areas. This allows you to increase the vibrance of clothing and the 
background without adversely affecting the skin color.

• Purity – Highlights: Reduces the saturation in the highlights.

• Purity – Shadows: Reduces the saturation in the shadows.

Color Range

In the Color Range section of the pane are swatches for eight colors: red, orange, yellow, green, aqua, blue, 
purple and magenta. Clicking on one of the colors will let you adjust the hue, saturation and brightness of 
the selected color range. Other settings in the pane include:

• Range: This slider lets you narrow or widen the range of the selected color.
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• Hue: Changes the hue for the selected color range.

• Saturation: Adjusts the saturation of the selected color range.

• Brightness: Adjusts the brightness of the selected color range.

You can also use the pane’s Targeted Dropper tool to click on a section of your photo and adjust the hue, 
saturation or brightness dynamically. To do this, click on the tool and choose which parameter you would 
like to adjust. Then click in your image on a color you would like to adjust and drag the cursor to the left or 
right to decrease or increase the effect.

CROSS PROCESS

This filter simulates the effect of processing film deliberately 
with the incorrect chemistry. It creates unnatural colors and high 
contrast.

• Color: A drop-down list of cross-processing types (Blue, 
Green, Yellow, with Strong options).

• Amount: Controls the overall strength of the filter.

• Brightness: Adjusts the overall brightness.

• Contrast: Adjusts the overall contrast.

• Saturation: Adjusts the underlining saturation.

CURVES

The Curves pane is a powerful, advanced tool for adjusting contrast 
and color in your image. The buttons at the top of the pane let you 
adjust the composite RGB channel, or you can adjust the individual 
Red, Green or Blue channels independently.

In the main part of the pane, the left side of the X-axis represents 
the dark tones in your image, while the right side represents the 
light tones. By clicking on the line at the center of the pane and 
dragging it up or down, you adjust those specific tones making 
them lighter or darker. (It is often helpful to keep an eye on the 
Histogram when making adjustments with Curves.)
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DYNAMIC CONTRAST

Dynamic contrast adds clarity—also known as tonal contrast—to 
your image, making it pop. It can be a strong effect, so it is often 
combined with masks to help lessen the effect in certain areas of 
an image (clouds in a sky, for example, often look surreal with too 
much Dynamic Contrast applied to them).

The top portion of the pane adjusts the contrast in areas of small, 
medium and large detail; moving the slider to the left decreases the 
contrast, while moving the sliders to the right increases them.

Because adjusting the contrast in extreme ways can affect an 
image’s tonal qualities, the bottom section of the pane lets you 
make adjustments to the highlights and shadows to recover detail, 
in the white and black areas, and increase vibrance.

FILM GRAIN

The Film Grain filter is designed to add a classic film grain look 
to your photos. It operates identically to the section found in 
the Black & White filter, but lets you add grain without having to 
convert your photos to black and white. 

To add grain, choose from the drop-down list of popular black and 
white films. The Amount slider controls the strength of the effect, 
while the Size slider adjusts the scale of the grain.

GLOW

This pane adds a soft-focus glow to the image. The styles section 
and the More pop-up include a number of different glow types. 
Adjustable settings for the Glow pane include:

• Amount: Controls the overall glow strength.

• Halo: Sets the radius of the glow effect, creating a 
fuzziness to your image’s edges.

• Mode: Lets you set the blending mode for the glow 
effect.
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GRUNGE

This filter is used to add a dirty or grungy look to your image. 
Settings in this pane include:

• Amount: Adjusts the overall strength of the grunge.

• Brightness: Adjusts the overall brightness of the image.

• Saturation: Adjusts the underlying saturation.

• Detail: Adjusts the amount of detail.

• Glow Amount: Adds a glow to the grunge.

• Mode: Selects the glow blending mode.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.

HDR LOOK

This filter recreates the HDR style of tone mapping, with 
accentuated edges and sharpening. This one, like dynamic contrast, 
often benefit from masking or blend modes. Settings include:

• Compression: Compresses the tone to reveal highlight 
and shadow detail.

• Detail: Increases the local contrast of details and edges.

• Clarity: Increases the global contrast.

• Highlights: Recovers detail in the highlights.

• Shadows: Recovers detail in the shadows.

• Vibrance: Adjusts the vibrance of muted colors.

• Glow: Adds a bright glow.

• Grunge: Adds a dark gritty look.

LENS BLUR

This filter creates a blur, based on a camera lens such as a tilt-shift 
or a shallow depth of field look. You can use the Masking Bug to 
adjust the amount of blur through your image, or brush in or out 
the effect where you want it. The filters settings include:

• Amount: Adjusts the overall strength of the blur.

• Optic Quality: Controls the aperture shape in the inner 
and outer feather.

• Sides: Sets the number of blades in the lens aperture, 
which changes the shape of the bokeh.

• Curvature: Sets the curvature of the aperture blades.

• Blooming: Adjusts the highlight bokeh.
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• Brightness: Controls the overall brightness of the blur.

• Contrast: Controls the contrast of the blurred areas.

• Noise: Adds simulated film grain to the blurred areas.

LUTS

The LUTs filter applies a color look-up table (LUT) to transform 
the underlying color of an image. LUTs were first used with video 
applications to provide color-grading (and other) effects to film, 
and they are increasingly popular in still photography. The Styles 
section has a few default effects you can apply, and you can also 
import your own LUTs, by clicking the Import button inside the 
filter. (Effects can import common LUT file formats, including .3DL 
and .CUBE file types.)

• Category: This pop-up menu lets you choose from one of the pre-installed LUT categories, or 
any categories you have imported into Effects.

• LUT: Displays the available LUTs within the chosen category.

• Contrast: Lets you adjust the underlying contrast.

• Saturation: Adds or reduces saturation.

NOTE: See “Extras” on page 11 for information on how to use the Extras 
Manager to import LUTs into Effects.

NOISE REDUCTION

Use this pane to reduce luminance and color noise, while 
maintaining image detail. The styles section includes a number 
of different noise reduction options, based on the type of image 
you’re working on.

• Luminance: Adjusts the overall strength of the noise 
reduction applied to the luminance or detail of the image. 
Hold down the Alt/Option key to see just the luminance 
while adjusting this slider.

• Color: Controls the amount of noise reduction applied 
just to the color or chroma of the image.

• Detail: Controls how much edge detail is protected. Hold down the Alt/Option key to see the 
edge mask while adjusting this slider.

• Apply to: Allows you to limit the noise reduction to just a portion of the image based on 
color or brightness values. Options include highlights, shadows and midtones, as well as color 
ranges. To set a custom color range, click the Dropper icon and click on a color area that has 
the noise you wish to remove. Use the Range slider to adjust the range or fuzziness of the 
color range to apply the noise reduction to.



ON1 Effects 2020 User Guide	 Part 2: Working in Effects	 62

PHOTO FILTER

This filter recreates traditional, solid color lens filters used for 
warming and cooling effects, as well as gradient, bi-color and 
center-spot filters. You choose the filter type from the pop-up 
menu at the top of the pane, then adjust the settings to your 
liking. Each type offers different options for selecting a filter color 
(or colors, in the case of the Bi-Color type), adding saturation or 
polarization, and more.

The Solid option includes a section for choosing the single color 
you wish the filter to be, and an Amount slider for how strong you 
want the effect. The Polarizer slider adds a polarization effect, 
which can sometimes help clear haze or enhance the blues and greens in an image.

The Bi-Color and Graduated filter options let you choose filter color (or colors), feather for the filter 
transition, and a direction for the effect.

The Center type works much like the Graduated option, with the difference being that the filter radiates 
from the center of your image, and you can choose the center to be either clear or colored.

SHARPENING

This pane helps add sharpness to your photos, to compensate 
for a moving subject or a slightly out-of-focus camera, or for an 
illustrative effect. ON1 Effects 2020 offers three algorithms for 
sharpening, High-Pass, Progressive and Unsharp Mask. Which one 
you use depends upon the image or your personal preferences. 
The styles section and the More pop-up have a wide range of 
sharpening styles to help you get started.

• Type: Chooses the sharpening method. Each sharpening 
method has its own set of sliders.

• Amount (all types): Controls the overall strength of the 
sharpening for each sharpening type.

• Halo (Unsharp Mask, High Pass): Sets the radius of the sharpening effect. Smaller amounts 
keep fine detail, while larger amounts can exaggerate edge detail.

• Threshold (Unsharp Mask, Progressive): Controls the sharpening effect based on contrast in 
your photo. Larger settings means that smoother areas do not get sharpened.

• Detail (Progressive only): Controls sharpening in small details.

• The Protect section protects highlight, and shadow areas and skin tones from having 
sharpening applied.
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SKIN RETOUCHING

The Skin Retouching pane is used to reduce blemishes, smooth 
skin and reduce shine on skin. The styles at the top of the pane 
represent a range of adjustments, from subtle to strong, and the 
More pop-up menu has a number of additional styles for you to 
choose from, depending upon your image. Other settings include:

• Blemishes: Adjusts the strength of acne, pores and fine 
lines.

• Smoothing: Adjusts the strength of smoothing similar to 
makeup foundation.

• Shine: Adjusts the strength of the skin shine.

• Evenness: Adjusts skin color consistency across the entire face. It is great for correcting 
overly yellow highlights, shadows that may be green or reducing redness in noses and ears.

• Skin Color: Use the Color Dropper icon to select the skin color. Click the icon to activate it 
and single click again on the color of the skin in the image.

• Color Well: This will display the color you have chosen with the Color Dropper. Clicking on 
the well will let you choose a different color to represent the skin.

• Range: Adjusts the precision of the color selected.

SPLIT TONE

This filter applies a duotone-style effect by using a gradient map 
that tints the dark and light portions of the image in different hues. 
This can be used to age an image and give it an antique or vintage 
look. The styles section has a selection of popular split-tone 
effects, and you can create your own by manipulating the sliders to 
choose a map for the highlight and shadow colors.

To use the pane, you can use the Hue slider in each of the sections 
to choose the colors you want for highlights and shadows. The 
Amount slider controls the strength of the color, and Balance sets 
the balance between the shadow and highlight colors, letting you 
make one of the colors more dominant.

The Mode pop-up sets the blending mode for the split tone. The options you can choose from are Normal 
(no blending), Color, Lighten, Darken, Multiply or Screen.
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SUN FLARE

This filter adds realistic-looking sun flares, sun stars and bokeh 
overlays to a photo. You can resize, move and adjust the tone 
and color of the effect, and can also add toning similar to the 
standalone Sunshine filter. The Type pop-up lets you choose 
between the three options (bokeh, flare or star), and the Texture 
menu displays a range of options for the chosen type.

The Tone & Color section of the filter lets you adjust the 
brightness, saturation and hue of the current texture.

To move the position of the texture, click the icon next to the 
Transform label, then click and drag on the overlay to the desired 
spot. You can use the Scale slider to enlarge the overlay, and you 
can rotate or flip it by clicking on the icons to the left of the Fit to 
Canvas button.

The bottom of the Sun Flare pane includes a version of the 
Sunshine filter, letting you adjust the warmth and saturation of the 
overall effect. The Fade slider gives a matte look to the final effect.

NOTE: The Sun Flare replaces the Lens Flare filter found in earlier versions of 
Effects. If you have an older photo that used the Lens Flare filter—or if you have 
a preset that used the filter—the pane will show up when you open the Effects 
tab. You just won’t be able to add the pane from the Filters list to new images.

SUNSHINE

This filter increases the appearance of sunshine in a photo, and can 
help to make a flat, cloudy day more vivid. The controls are fairly 
straightforward, including adjustments for the strength (Amount), 
warmth and saturation. You can use the Glow slider to add a bright 
glow to your image.
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TEXTURES

The Textures filter places a texture over the image to add a stylized 
look and is similar to the Borders filter in scope and functionality. 
ON1 Effects 2020 comes with an extensive set of textures that 
you can add to your photos, ranging from fabric, metal, stone, text 
and more. You can also import your own textures directly into the 
Borders filter pane, or via the Extras Manager. Texture files can be 
almost any image format (JPEG, TIFF, Raw or Photoshop).

When loading a texture file, it will be rotated automatically to 
match the orientation of your image. You can override this with 
the rotate and flip tools, and use the Transform option to scale the 
texture’s size over your image.

The Textures pane has Category and Texture pop-ups at the top 
of the pane, used to help you narrow your texture search. There 
are nine texture categories, sorted by type, and any user-imported 
textures will also appear in this list.

Once you have chosen a texture, you can adjust its blending mode 
and opacity, and, if the texture has color, you can adjust its hue, 
saturation and brightness. Alternatively, if the texture is black or white, you can colorize it by clicking on 
the Colorize button in the bottom half of the pane.

The Transform section at the bottom of the pane lets you scale the texture up or down in size. You can 
also rotate or flip the texture by clicking the buttons at the bottom of the screen, which can be helpful to 
achieve the look you desire.

NOTE: See “Extras” on page 11 for information on how to use the 
Extras Manager to import textures (and other extras), along with additional 
information for preparing files for Borders and Textures.
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TONE ENHANCER

The Tone Enhancer controls the brightness and contrast, or tone, 
of the image and lets you recover detail in the highlights and 
shadows, and adjust the white or black point. It also includes a 
curves section at the bottom of the pane.

• Auto Button: The auto button sets the white and black 
points automatically, adjusting all of the primary tone 
settings to balance the histogram.

• Exposure: Adjusting this slider to the right will lighten 
your image. Adjusting to the left will darken your image.

• Contrast: Increase or decrease the contrast.

• Highlights: Darkens the highlights, recovering detail.

• Shadows: Lightens the shadows, revealing details.

• Whites: Adjusts the white point, adding or removing contrast in the highlights.

• Blacks: Adjusts the black point, adding or removing contrast in the shadows.

• Compression: Compresses the tone to reveal highlight and shadow detail.

• Detail: Increases the local contrast in the image.

• Clarity: Enhances large edges to add clarity.

• Curves: The curves dialog is a powerful, advanced tool for adjusting contrast and color. (See 
the Curves filter on page 58 for complete details on adjusting the curves.)

VIGNETTE

The Vignette pane creates flexible vignettes which focus a viewer’s 
eye toward the center of the image by darkening the edges of the 
frame. The buttons at the top of the pane let you quickly apply a 
vignette and then customize the look with the advanced controls. 
Styles apply common vignette types.

• Brightness: Controls how light or dark the vignette is.

• Size: Controls the size of the vignette.

• Feather: Controls the hardness of the edge of the 
vignette.

• Roundness: Controls the shape of the vignette from square to round.

• Type: This drop-down menu lets you select a Normal, Subtle, or Soft vignette effect. The 
Priority option will let you preserve highlights (by using the Tone Enhancer filter in Effects) 
when applying the vignette.

The Center Tool at the bottom left of the pane lets you to select the center point of the vignette. Click 
on the tool icon to activate and then click on the area in the image you wish to make the center of your 
vignette.
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VINTAGE

The Vintage filter is for adding an aged, vintage look reminiscent of 
films and photographic papers from the mid-to-late 20th Century.

• Color: A drop-down menu of various color styles to apply 
to your image.

• Amount: Controls the overall strength of the filter.

• Saturation: Adjusts the saturation of the original image.

• Film Grain Amount: Adds film grain to the image.

• Film Grain Size: Controls the grain size.

WEATHER

This filter adds weather-inspired overlays to a photo. The 
Precipitation section at the top lets you add rain or snow overlays, 
by choosing a type from the Texture pop-up menu. You can adjust 
the opacity of the effect, and can scale, flip or rotate the overlay 
via the Transform section of the panel.

You can also add fog effects to a photo. To turn this effect on, 
raise the Amount slider in the Fog section at the bottom of the 
pane. The Position pop-up menu includes a number of gradients 
for applying the effect (choose All to apply the effect to the entire 
image). Choose the one that is the best starting place for your 
photo.

The Distance and Transition sliders act upon the gradient, letting 
you choose the intensity and length of the Position gradient, while 
the Rotation slider lets you adjust the angle.
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PART 3: USING LOCAL ADJUSTMENTS
You can easily make local adjustments to portions of 
an image in ON1 Effects 2020. You can apply these 
adjustments using either the Adjustment Brush or the 
Adjustable Gradient (or both, if desired). You can create 
as many local adjustments as you need on an image (by 
clicking on the Add Layer button at the top of the Local 
Adjustments section). 

Local adjustments can be used to apply a gradient filter 
to darken a sky, for example, or to add a more detailed 
vignette. Local adjustments are in essence a mask that is 
applied to a portion of your image, and you can manipulate 
those masks in powerful ways with both the blending 
modes and the luminosity options in the Local tabs.

Operations you can perform with local adjustments include 
tone (exposure, contrast, highlights and shadows, detail), 
color (white balance, saturation and vibrance) and detail 
(structure and noise). Each local adjustment layer can have 
completely different settings and work on different parts 
of your image. You can also use local adjustments to paint 
with color over part of a photo, to perform specialized 
tasks such as skin retouching or to replace the color of an 
object. 

Local adjustments are independent from Effects tab; your 
local adjustments remain intact as you work on your photo, 
and you can go back and forth between the two tabs.

TIP: You can name each adjustment layer by double-clicking on the word 
‘Adjustment’ in the pane. This can be helpful when you have a lot of adjustment 
layers and wish to remember which adjustment did what.

The Local Tab
To create a local adjustment, click on the Local tab or click on the Local group in the Tool Well. If there are 
no local adjustment layers present, Effects will add one. If you want to add additional adjustment layers, 
click the Add Layer button. The top of each adjustment layer includes the following options:

• Opacity: Sets the opacity of the adjustment.

• Styles: The pane has a number of canned styles for you to start with, including ones for 
lightening or darkening (dodging and burning), adding vibrance, fixing teeth or red eye, and 
many more. (You can also save your own styles via the More pop-up menu.)

Adjustment panes let you adjust basic tone and color settings 
to selective parts of a photo. You can set the opacity of the 
adjustment, as well as apply masks and blending options.
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The main section of the Local tab has all of the same options found in the Tone Enhancer pane in the 
Effects tab: Exposure, Contrast, Highlights, Shadows, Detail, and Color Temperature, Tint, Saturation and 
Vibrance. In addition to those settings, the local adjustment pane includes a Noise slider, designed to help 
reduce noise on a targeted level (most often seen in the shadows).

These controls work the same way inside the Local Adjustments panel. One difference is that, since a local 
adjustment is actually a layer that sits on top of your global adjustments, ON1 Effects 2020 provides you 
with a number of blending options for each adjustment. Blending modes determine how the selected layer 
blend with the items below it in the image stack.

Click on the Blending Options gear icon at the top of the Local tab to drop down the Blending Options. The 
blending option controls are:

• Blending Options: A pop-up list of blending modes. 
There are 24 common blending modes available in 
the list, including Normal, Lighten, Darken, Screen, 
Multiply, Soft Light, Hard Light, Overlay and Color.

• Apply To: This lets you apply the blending mode 
to a specific color or tonal range. The options are; 
All (the default), Highlights, Midtones, Shadows, 
Reds, Greens, Blues, Magentas, Cyans, Yellows, 
Flesh Colors, Vivid Colors and Neutrals. (You can 
also manually choose a color range by selecting the 
Dropper Tool in the pane and clicking on a color in 
your image.) 
 When you choose one of the options in this 
menu, the adjustment is only applied to that part 
of the image that is based on the lightness, hue, or saturation range specified. The Range 
slider expands or contracts the selected option, and the Highlights, Shadows, and Skin sliders 
protect those settings from your adjustments.

ABOUT BLENDING MODES

At their basic level, blend modes determine how 
the pixels on one layer interact with the layers 
below it. With 24 blend modes in ON1 Effects 
2020, it might be difficult to know which ones 
to use in any given situation, but they can easily 
be grouped into Normal (the default mode) 
and five categories: Darken, Lighten, Contrast, 
Comparison, and Color/Luminosity. 

Normal is the most widely used: it simply applies 
the effect to all of the pixels in the adjustment 
(or effect), assuming the layer opacity is 100%.

The other modes apply different levels of that 
category’s effect using various mathematical 
formulas, and sometimes it can be hard to know 
which mode will work best with what photo. 

The Adjustment pane’s Blending controls give you extensive 
options for applying local adjustments to targeted tonal and 
color ranges in an image.
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Most often, when you know how you want to apply an effect—by darkening, for example—you’ll need to 
experiment a bit with the different modes in that category to determine which mode works best.

PAINTING WITH COLOR

The Paint with Color option at the bottom of the panel 
lets you use the Local Adjustment brush to select a 
color and paint it into your image. It is designed for two 
situations: when you wish to even out to portions of an 
image by blending existing color, and to replace the color of an existing object. 

The Paint with Color section has three options, Solid Paint, Replace Color, and Classic, and a color swatch 
for the chosen color. You can choose a color from your image by clicking on the eyedropper icon, or you 
can click on the swatch and choose a color from the system color picker. 

Solid Paint will paint over anything you brush with the chosen color; think of it as painting with a Normal 
blending mode. Replace Color will replace the hue, but not the luminosity, of the color you are brushing 
over; it is essentially painting with a Color blend mode, in which whites are preserved. 

The Solid Paint option is an ideal skin softening tool; use the eyedropper to select a middle tone section of 
skin, and, using a low opacity setting on your brush, you can paint over parts of the skin with the brush. 

Working with Local Adjustments
When adding a local adjustment layer, click on the tool you wish to use in the Tool Options bar at the top 
of the window. The Adjustment Brush is perfect for working with specific subjects or areas in an image: 
a person or primary object that you wish to brighten, shadow areas that you wish to darken, and more. 
It works in the same manner as the regular Masking Brush: you set the paint mode (in or out), brush size, 
feather and opacity, and brush in the areas you wish to paint an effect in or out.

The Adjustable Gradient is designed to apply a gradient mask over a section of an image: most commonly to 
darken a sky, for example. Because the local adjustment tools are for working on a mask, you have all of the 
masking and blending options you have throughout Effects, and you can use one or both tools—in addition 
to the Refine, Chisel and Blur Mask tools—to refine your adjustment mask as desired. 

To apply a standard gradient to a local adjustment, click on the tool, then click in the image roughly where 
you wish the effect to be. You’ll see the outline of the gradient, which is called a bug. You can use the 
handles on the bug to move your gradient, increase or decrease the length of the gradient, or rotate it.

You can change the gradient shape via the Tool Options bar: in addition to the standard dark-to-light 
horizontal gradient, you can also create a circular gradient and a reflected gradient, which is like the 
horizontal gradient, but goes from black (no effect) at the outer edges to white (full effect) in the center.

TIP: To see the mask created by the Adjustable Gradient, choose Show Mask 
from the View menu. You can choose a red overlay, which presents the mask 
over your image, or grayscale, which shows the mask as black to white tones. 
These views can be helpful in understanding how these gradients work.
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MANIPULATING A LINEAR GRADIENT MASK 

Once you’ve added a gradient to an image, you can 
modify it by accessing the parts of the gradient overlay: 

• To move a gradient, click on the big circle at the 
center of the gradient and drag. 

• To resize a radial gradient, click and drag on the 
solid line. 

• To adjust the feather (hardness) of the mask, 
click and drag along the dashed line. 

• To rotate the mask, click the smaller circle near 
the gradient center and drag. 

When working with local adjustment masks, all of the tools in the Refine group—the Refine Mask, and the 
Chisel and Blur tools—can be used to help give you create smoother and more realistic masks.

OTHER MASKING OPTIONS

Every local adjustment has its own mask, and it uses the same masking options and controls found in 
Effects. To access the mask, click on the mask icon in the title bar of the local adjustment layer. There you 
can copy and paste masks, create luminosity masks, and create masks based on color ranges. For specific 
details on how to work with these masking options, see “Filter Masks” on page 48.
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PART 4: PRINTING
While editing and stylizing your photos are probably the most important tasks you’ll do on a regular 
basis inside ON1 Effects 2020, there will be times when you want to print your photos or export them in 
different formats and sizes. Whether it’s creating high-quality prints, or sharing your photos with others, 
Effects has all the functionality you’ll need to get your photos where you want them to be. 

ON1 Effects 2020 has a flexible print engine that can print photos at any size. You can print photos 
individually; or multiple versions of a photo, package style, on a single piece of paper. You can even print 
when using Effects as a plug-in from Lightroom, Photoshop or Apple Photos. 

The print window can be opened by clicking on the Print icon in the module selector, or by selecting the 
Print command from the File menu. It has the following components:

A.	Preview: Displays the photo being printed.

B.	 View Selector: The first three icons are not applicable inside Effects; the icon on the far right 
turns soft proofing on and off.

C.	 Page view: Displays the number of pages being printed. (Not applicable in Effects 2020.)

D.	Printer pane: Contains options for output—printer or PDF—as well as printer, page setup, 
page size, number of copies, resolution, and printer profile and rendering intent.

E.	 Print Area pane: Contains options for fitting and selecting the print image size.

F.	 Watermark pane: For adding a watermark to printed photos.

G.	Sharpening: Options for sharpening during the print process.

H.	Print/Cancel: Print the current photo or cancel the operation.
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NOTE: The print engine in Effects 2020 is based upon the engine inside ON1 
Photo RAW 2020, which has the capability to print multiple photos at a time. 
Because Effects can only work with a single photo, some of the options, like 
contact sheets and some view settings, are not applicable in Effects.

Printing Options
The four panes in the Print window—Printer, Print Area, Watermark, and Sharpening—each deal with a 
specific printing-related task.

PRINTER PANE

The Printer pane is where you set the printer-specific features 
for your output. It has two modes, which are chosen by clicking 
on the icon at the top of the pane: Print, which lets you print to a 
connected printer, and File, which will print the selection to a PDF. 

When choosing to output to a printer, you’ll set the specifics of 
your printer, the paper size you wish to print to, the resolution, 
orientation, and the number of copies. When choosing resolution, 
make sure that you are printing at the printer’s optimal resolution. 
Most photo printers, for example, work best with a file that has 
between 240 and 360 ppi. (Effects will use its internal resampling 
engine to ensure that your photo is at the final resolution you 
choose.)

At the bottom of the pane is a section for choosing a printer-specific color profile; choose the media profile 
for the paper type you are printing to. If you wish the printer to handle the color conversion, select the 
Printer Managed Color option in the Profile list.

The rendering intent is related to the conversion of an image’s colors to fit within the color range (or gamut) 
of the printer. The default intent, Perceptual, will change all of the colors in a photo proportionally to fit 
within the printer’s range of colors. The other option, Relative Colorimetric will only change the colors out 
of the printer’s gamut, to the closest in-gamut color. Depending upon the image, you might need to play 
with the intent settings, but Perceptual is usually the best place to start. 

When choosing a specific paper profile—as opposed to Printer Managed Color—you can use Effects’ Soft 
Proofing feature to look at out-of-gamut colors in your photos. Click on the soft proof icon at the bottom 
left side of the window to view the photo with your chosen paper. (See page 39 for more.)

NOTE: Effects’ Print feature will work with borderless printing options as well. 
Be sure to choose your printer’s borderless options in the page setup pop-up. 
Different printers will have specific borderless settings, so check the manual to 
see how to turn borderless printing on.

The Printer pane sets printer-specific options for 
the current print job. You can also choose to render 
the print job to a PDF file.
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Printing to a file

In addition to sending images to a printer, you can also choose to export the current print job to a file. This 
can be helpful if you are submitting prints to an online service or to print remotely.  To use this option, click 
on the File icon at the top of the pane. Effects will ask you for a filename and a location to save the file. 
Choose a page size for the file from the Page Size pop-up, and adjust your print area settings. When you 
choose Print, Effects will create a PDF of the photo (or photos) and save it with the name and destination 
you specified earlier.

PRINT AREA PANE

The Print Area pane is where you set the options for the size of the 
print, and how you wish your photos to be printed. You can also 
choose whether to print photos individually or package-style. (The 
contact sheet option, while present, is not applicable in Effects, as 
it is largely designed to gang-print a set of different photos.)

The top of the pane includes preset styles for either fitting the 
current photo inside the size of the print, or filling the entire size 
of the print. It also includes options for printing at common print 
sizes, including 8x10, 5x7, 4x6; and options for printing to a contact 
sheet. You can also create custom print sizes via the Custom 
section at the bottom of the pane; just set the width and height of 
the print size, and whether you wish to fit the image to the print 
size, or to fill the frame with it. If you would like to save this print size as a style, click on the More pop-up 
at the top of the pane, and choose Save as New Style from the menu. You’ll then be able to recall that style 
from the More pop-up whenever you print.

If you are printing multiple copies of a single photo, Effects will attempt to put as many photos at your 
chosen print size on the paper size as defined in the Printer pane. To print only one photo per page, click 
that option at the bottom of the Print Area pane.

Page size vs. print size

It’s worth understanding the distinction between the page size and the print size. In some cases, the two 
will be identical. For example, if you wish to print on 4x6-inch photo paper, you would choose that option 
in the Printer pane’s Page Size pop-up, and then 4x6 in the Print Area’s Custom pop-up. Depending upon 
the aspect ratio of your photo, you then might need to choose Fit or Fill to get the proper crop. Fit does 
exactly what it sounds like: it will fit the entire photo within the bounds of the photo’s dimensions, which 
means that there could be some extra white space around the final print. Fill will resize the photo to fill the 
dimensions of the chosen print size, centering the image. 

In our example, a 4x6-inch print has an aspect ratio of 2:3. If the photo you are printing has that aspect 
ratio, then Fit and Fill do the exact same thing: the photo will fill the print area without any cropping.

For package printing, where you wish to generate multiple prints on a larger sheet of paper, you’ll set the 
specific size paper you are printing to in the Printer pane, and then set the appropriate print size for each 
photo in the Print Area pane.

The Print Area pane is for setting the actual print 
size of the photo or photos you are printing.
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WATERMARK PANE

The Watermark pane adds an overlay to the printed image, and is 
most often used for your logo, signature or copyright. Watermarks 
generally need a transparent background, so make sure your 
watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark. Once you’ve added a 
watermark file, it will be saved to the Logo File pop-up.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs to be at least 600 pixels wide. Otherwise, 
it could appear pixelated on the print.

SHARPENING PANE

In most cases, and depending upon the media type you print 
to—glossy papers often benefit from additional sharpening, for 
example—you’ll need to add an additional sharpening step when 
printing. This is an additional level of sharpening beyond anything 
you might have applied in the Effects or Local Adjustment panels. 

The Sharpening pane lets you select a type of sharpening that will 
be applied to your photos during the printing process. The pop-up 
menu has a set of options for general sharpening, including ones 
for a standard print, glossy papers, details, high-pass sharpening, 
and many more. Depending upon the image, you might need to play with the settings here; performing test 
prints on small sections of a photo can often be quite helpful in determining the proper level of sharpening 
in a print.
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PART 5: EXPORT
Export is a special panel that is always available in 
ON1 Effects 2020. The Export pane gives you the 
power of ON1’s patented Resize technology in an 
easy to use panel, letting you export your photos 

with incredible flexibility, ease and control.

To open the panel, click the Export icon in the lower right corner 
of the module selector, or choose Export from the File menu. Once 
selected, the Export panel opens on the right side of the Effects 
window, letting you select a group of options as you prepare to 
export a photo. By default, the panel includes two active panes, 
which are located at the bottom of the Export panel: File Type and 
Location. Adjusting these two options is required when exporting 
a file, but you can also expand your export options with the Photo 
Size, Watermark, Sharpening, Tiling, Gallery Wrap, and Rename 
panes.

File Type
The File Type lets you choose what format you want your photo to 
be exported as, along with a color profile that you wish to assign 
to the exported file. The type options are Photoshop, Photoshop 
Large Document, JPEG, TIFF, and PNG.

Saving as JPEG lets you choose a Quality setting, with 100 being 
the highest.

Location
Click the Choose button to select a location, or click on the Save 
To pop-up for more options, including:

• Current Folder will write the file to the same location as 
the original file.

• Folder lets you choose a location by pressing the Choose 
button

• Round Trip (only available when exporting through 
Adobe Lightroom) saves the file over the original and 
uses the same format, bit-depth, color space and name.

With regard to the other options in this pane, If Prevent Overwrite 
is selected the word ‘copy’ will be added to the file(s); otherwise 
it will overwrite your original image if the destination is set to 



ON1 Effects 2020 User Guide	 Part 5: Export	 77

Current Location. You can also have Effects open the folder you exported your image to by choosing the 
Show in Finder (MacOS) or Show in Explorer (Windows) option from the After Export menu.

PHOTO SIZE

The Photo Size pane displays the original image size when you 
first open it. You can simply type into the Width or Height fields 
to change the document size, or you can choose from a variety 
of preset sizes—including standard photo paper sizes—by clicking 
on the pop-up menu underneath the Resize To pop-up.

Keep in mind that the Width and Height fields are locked 
together to maintain the photos proportions. Changing the 
width will change the height proportionally. Export does not support non-proportional scaling. If you would 
like to change the proportions of the image it requires cropping.

The Long Edge and Short Edge options in the Photo Size pane are useful when you want to lock one edge 
to a specific length or width and don’t care about the sizing of the other edge. Simply choose which option 
is the important one for your photo, enter the dimensions, and Export will resize your photo accordingly.

The units of measurement can be switched by clicking the down arrow. You also control your resolution in 
pixels per inch. Use this setting to optimize for your output device.

The Photo Size presets make it easy to set the width/height of your image in a preset size. Use the drop 
down menu to select a preset size or choose custom to create your own.

The Image Type drop down provides a few options for resizing:

• General (ON1 Resize) uses the ON1 Resize algorithm (formerly known as Genuine Fractals): 
This is the classic, patented, fractal-based algorithm that has made Perfect Resize the 
standard for over a decade.

• Low-Res JPG is best for enlarging low resolution JPEGs (this setting use the bicubic algorithm 
method).

• Portrait works well for resizing portraits protects skin tones from artifacts (uses bicubic 
algorithm method).

• Landscape is great for Landscape photos (uses ON1 Resize algorithm).

• High Detail is great for images with many small items (uses ON1 Resize algorithm).
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WATERMARK

The Watermark module allows you to add an overlay to the 
image, most often used for your logo, signature or copyright. 
Watermarks generally need a transparent background, so make 
sure your watermark file is a PNG or PSD.

The module has the following options:

• Choose: Click the Choose button to select the file you 
wish to use as your watermark.

• Size: This slider controls the size of the watermark file.

• Inset: This will determine the percentage in which the 
file is inset from the edge, based on the Position (see 
below).

• Opacity: This sets the opacity of the watermark.

• Position: This grid sets the location of the watermark. 
Click on the square of the location you desire.

When working with watermarks, make sure your watermark file 
is sufficiently large for your usage. For example, if you want it to 
appear 2 inches wide on a 300-ppi image, your watermark needs 
to be at least 600 pixels wide. Or if you want it to appear across an entire photo—such as when posting to 
social media—it needs to be the same size as what you are exporting for the web, typically over 1000 pixels. 
Using a watermark file that is too small will create a pixelated watermark appearance.

SHARPENING

The Sharpening pane adds additional sharpness to your image, 
and are designed to be general options for screen or print work. 
Using these controls can save you the workflow step of adding 
additional sharpening before printing and can help compensate 
for loss of sharpness due to dot gain from your printer. Sharpening should only be applied at the end of 
your workflow, just before printing. If you plan to do additional retouching or compositing work after 
resizing your image, you should disable the sharpening controls.

RENAME

This option may be used to rename the file name. The options 
include: Current Name, Text, Date and Number. The field to the 
right allows you to enter a custom name. The plus and minus 
icons will allow you to add or remove naming elements. Current 
Name will use the source name without the file extension. Text 
is used for assigning a custom text string. Date lets you add 
today’s date in any one of 12 standard formats. Number creates an automatically incremented number, 
starting with the number input in the field. Reset will clear all current settings.
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TILING

The tiling feature in Export divides an enlargement into smaller 
pieces so that the image can be printed on a smaller printer.

For example, you might want to create a mural that is 8 feet tall 
by 12 feet wide, but your printer can only print 24-inch wide 
strips. With the tiling feature you could automatically create four 
separate files that are 24 inches wide and 8 feet tall, to create 
your mural in sections.

With the tiling feature all you do is specify the size of paper 
you have to print on and if you would like the pages to overlap. 
Then Export will resize your image and section it down into the 
individual tiles.

To use the Tiling pane, follow these instructions:

1.	 Set the Width/Height fields to the size and orientation 
of paper you wish to print on, or select the number of 
rows and columns instead.

2.	 Set the Overlap size. The overlap makes each tile 
overlap so you can tape multiple panels together and corrects for printer margins if you are 
not printing borderless.

The preview will show cyan guide lines for each tile that will be created.

GALLERY WRAP

The Gallery Wrap feature is designed to help you print on 
canvas. When making enlargements for canvas it is common 
to wrap a portion of the image around wooden stretcher bars. 
These are used for mounting the canvas. These are commonly 
called gallery wraps. However, if the photo has important detail 
near the edges of the image they may be lost in the wrapping 
process. The Gallery Wrap feature in ON1 Resize automatically 
creates extended margins by reflecting or stretching the areas 
near the edge of the image allowing the photographer to create 
a gallery wrap without having to sacrifice any of the original 
image. The Gallery Wrap feature allows you to select the 
thickness of the canvas mounting bars and offers a variety of 
techniques for creating additional margins.

To use the Gallery Wrap feature follow these instructions:

1.	 Set the Thickness control to the amount of margins 
you would like to add. A good rule of thumb is the 
thickness of the stretcher bars, plus half an inch.

2.	 Select the Type you would like to use.

3.	 If you wish to add an overlay to the wrap wings, set the color and opacity.
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The Gallery Wrap feature has several settings for adding margins and adjusting the look of the wrap. The 
Type pop-up has four options:

• Reflect: Copies an area equal to the thickness setting around your image, then flips each side 
and adds it as the margins. This is a good general purpose technique.

• Reflect Soft: Does the same as the Reflect method but softens the added margins.

• Stretch: The Stretch method takes a small area around the edge of the image and stretches it 
to add the margins.

• Stretch Soft: Does the same as stretch, but softens the added margins.

The Thickness slider controls how thick your canvas stretcher bars are. Two inches generally works well for 
most gallery wraps.

You can also darken the wrap or add a solid color to the wrap area with the Overlay Color add Opacity 
sliders.

EXPORT PRESETS

Presets remember all of the settings and details selected in the Export window pane. To save a group of 
settings as a preset, click the Save Preset button at the bottom of the panel. Give the preset a name, and it 
will appear in the Presets pop-up at the top of the Export panel.

NOTE: Unlike presets in other parts of ON1 Effects 2020, you can’t export or 
import presets from the Export panel.

EXPORTING YOUR PHOTO

When you finish your export settings and are ready to save the file, click the Export Now button. If you 
wish to start over in the pane, click the Reset button, or click Cancel to stop the export process and return 
to the main Effects window.

Quick Export
If you just want to export a version of your edited photo quickly, and without any of the extra options in 
the Export pane, choose Quick Export from the File menu. This option will export your file at its full size, in 
Photoshop, TIFF, JPEG  or PNG format, and with the name of your choice.
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EDIT MENUS
ON1 Effects 2020 (MacOS Only)

• About ON1 Effects 2020: Opens the About box and displays 
your version number. (This is in the Help menu on Windows)

• Preferences: Opens the preferences dialog. (In the Edit menu 
on Windows)

• Quit ON1 Effects: Quits ON1 Effects 2020.

File Menu

• Done: Saves your edited photo and quits Effects.

• Cancel: Cancels the current editing operation.

• New Canvas: [unused]

• Canvas Size: [unused]

• Quick Export: Saves the current image in Photoshop, TIFF, 
JPEG or PNG format.

• Export: Opens the export side panel.

• Print: Opens up the print dialog box.

• Manage Extras: Opens the Extras Manager window.

Edit Menu

• Undo: Removes the last file operation.

• Redo: Redoes the undo operation. This is only available if the 
last thing you did was an undo.

• Undo Delete: [unused]

• Redo Delete: [unused]

• Cut: Cuts the currently selected item.

• Copy: Copies the currently selected item.

• Paste: Pastes (copies) the items in the clipboard to the current 
location.

• Delete: [unused]

• Revert: Reverts to the original state of the current photo.

• Preferences (Windows): Opens the Preferences dialog.
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Mask Menu

• Invert Mask: Inverts the mask, what was hidden is revealed 
and vice versa.

• Reset Mask: Resets the mask to plain white.

• Copy Mask: Copies the mask.

• Paste Mask: Pastes the mask.

• Create Luminosity Mask: Creates a luminosity layer mask 
based on of a photo’s black or white tonal values.

• Show Mask: Displays the current mask either as a red overlay 
or as grayscale.

• View Mode: Sets the Show Mask mode to either red overlay 
or grayscale.

Settings Menu

• Reset All Settings: Resets all of the settings applied to a 
photo, returning it to the state it was when opened.

• Reset Effects Settings: Resets settings applied in Effects.

• Reset All Retouching Tools: Resets retouching applied in Edit. 

• Reset Local Adjustments: Resets any local adjustments.

• Reset Crop: Resets any cropping made to a photo.

• Save Settings as Preset: Saves the editing settings of the 
selected photo as a preset.

• Update Preset with Current Settings: If an image with a 
preset has had some settings changed, this lets you update 
the preset with the new settings.

• Rename Preset: Renames a preset.

• Delete Preset: Deletes a preset.

• Export Preset: Exports a preset as an ON1 preset file.

• Import Preset: Imports ON1 preset files.

• Get More Presets: Goes to ON1’s Photo Presets web page.
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View Menu

• Zoom In: Zooms the preview window in one increment. This 
will make the preview image larger.

• Zoom Out: Zooms the preview window out one increment. 
This will make the preview images smaller.

• Fit to Screen: This sets the preview image so that the entire 
image is on screen at once. Think of this as an overview of the 
entire image. This is the setting you will use most of the time.

• Actual Pixels: This sets the preview image so that it zooms to 
actual pixels or 1:1 also called 100%. This setting allows you 
to see every pixel in the image. This is useful when making 
precision adjustments.

• Preset Browser: Sets the Preset panel browser view to 1, 2 or 
3 columns.

• Show Clipping: Shows the clipping overlay view, displaying the 
pure white or black pixels in the current image.

• Show Focus Mask: Displays a green overlay on those portions 
of the current image that are in focus.

• Show Preview: Toggle to enable or disable the preview.

• Compare: Displays an adjustable split-screen view of the 
current image, with the Before view on the left side of the 
preview area.

• View Mode: Toggles between Filmstrip and Detail view.

• Preview Background Color: Lets you set the background color 
options.

• Enable Soft Proofing: Turns on soft proofing for the current 
image.

• Gamut warning: Displays colors that the printer can’t 
reproduce with a red overlay.

• Profiles: Displays a list of installed printer and display profiles; 
choosing a profile will apply soft proofing for that profile’s 
paper type.

• Intent: Lets you switch between perceptual or relative 
rendering intent for the current image.

• Simulate Paper and Ink: When turned on, Effects will set the 
white point and black point of the display to account for that 
of the chosen profile.



ON1 Effects 2020 User Guide	 Part 6: Effects Reference	 85

Window

• Minimize: Minimizes your screen.

• Zoom: Zooms your window to full-size.

• Full Screen: Toggles full-screen mode (hides menus).

• Navigator: Hides or shows the Navigator, Loupe, Histogram 
and Info pane.

• Solo Mode: Keeps only one pane open at a time.

• Open Quick View Browser: Opens the Quick View Browser 
overlay for the selected preset category.

• Show Bumper Labels: Hides/reveals the text labels in the 
module selector.

• Show Browser Panel: Hides/shows the Browser Panel.

• Show Control Panel: Hides/shows the Control Panel.

• Hide Panels: Hides or shows all Panels.

• Document Name: Shows the name, zoom level and bit depth 
of the open image.

Help

• Search: Searches the menu options (MacOS only).

• ON1 Effects 2020 Online Help: Opens ON1.com support 
page in your default web browser.

• Video Tutorials: Opens ON1.com product training page in 
your default web browser.

• Check for Updates: Checks with the ON1 update server to 
see if you are running the current version. If there is a newer 
version, you will be notified and be walked through the 
update process.

• Sign-In/Sign-Out: Uses your ON1 account login information 
to authenticate your copy of ON1 Effects 2020.

• Provide Feedback: Opens the default web browser and goes 
to the feedback page of the ON1 website.

• About ON1 Effects (Windows Only): Opens the about box 
with the version number displayed.

• Help Improve ON1 Products: Opens the Improve ON1 
Products dialog.

• Show ON1 Log: Diagnostic tool that can help ON1 support 
when you’re having issues with ON1 Effects 2020.
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PREFERENCES
ON1 Effects 2020 has a number of system-wide settings that you can set via the Preferences window. To 
access Preferences, either click on the gear icon at the lower left side of the screen, or choose Preferences 
from the ON1 Effects 2020 menu (MacOS) or the Edit menu in Windows. The Preferences window has four 
tabs: General, Files, Plug-Ins, System, Services. The settings in each tab are described below.

GENERAL SETTINGS

The General settings tab adjusts basic settings 
for the Effects workspace, including background 
color, scrolling controls and more.

Scrolling Controls

Lets you select how the mouse scroll wheel or 
scrolling gesture works. The options are:

• None: Default.

• Preview Zoom: Adjusts the zoom of the 
preview window. Scrolling up increases 
the zoom, scrolling down decreases the zoom.

• Preview Pan: Pans the image, like using the pan tool or navigator. It is important that the panning is 
comfortable, not too fast or slow or jerky.

• Brush Size: Adjusts the size of the current tool if relevant, such as a brush tool.

Preview Background Color

You may select the color of the background behind the preview image. The default is black. The custom 
option has a color picker where you can select your own background color.

Accent Color

Lets you choose the display color for highlighted items (folders, tabs, selections) in the Effects interface.

Application Language

Lets you change the display language for Effects. Auto will use your system’s default language (if available).

Check for Update on Launch

Enabled by default, the product will communicate with ON1’s software update server when you start ON1 
Photo; if an update is available it will prompt you to download or skip.
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FILES

The Files tab is used to determine what file type 
ON1 Effects will create when opening a file as a 
plug-in from an external application.

What to Edit

There are five options in this tab:

1.	 File Format: Sets the file type you wish 
to create: PSD, TIFF, or JPEG. If you wish 
to use a layered workflow, you must 
choose PSD.

2.	 Color Space: Sets the default color 
space when opening a copy of a file; the list includes Adobe RGB 1998, Apple RGB (MacOS), sRGB, 
ProPhoto RGB, or ColorMatch RGB. (If you imported a profile for use in the General preferences, it 
will also be available here.)

3.	 Bit Depth: Sets the bit depth for the file when opening a copy of a file.

4.	 Resolution: Sets the resolution when opening a copy of a file.

5.	 Show these options every time: If you do not wish to use a predefined set of file characteristics for 
opening photos from Lightroom or Photoshop, click this box.

Apply Lens Correction Automatically

With this option on, ON1 Effects will use the lens correction automatically on any raw photo when you 
view it in Detail, Filmstrip or Compare modes.

PLUG-INS

Plug-Ins is specific to using Effects as a plug-in 
Photoshop or Lightroom, and lets you set up 
conditions when opening files from these apps.

Photoshop

• Apply Results to: When editing in 
Photoshop you can choose to have your 
effect added to a copy of your current 
layer or to the current layer. You can also 
choose to start with the last used settings 
when launching Effects.



ON1 Effects 2020 User Guide	 Part 6: Effects Reference	 88

Lightroom

This preference lets you choose the specific options for files opened via the Plug-In Extras menu in 
Lightroom:

• File Type: The file type drop-down menu determines what type of file will be created. The default is 
PSD, which maintains layers. You can also select JPG or TIFF if you prefer those formats and are not 
concerned about maintaining layers. The last option is same as source, which maintains the file type of 
the original file, except for Lightroom raw files, which are saved as PSDs.

• Color Space: Sets the working color space; Adobe RGB, sRGB or ProPhoto RGB.

• Bit Depth: Sets the file bit depth, either 8-bit or 16-bit per pixel.

• Resolution: The resolution drop-down menu determines the resolution of the file.

• Stack with Original: When enabled, the new image is stacked with the original image.

• Use Original for Single PSDs: When enabled, if you select a single PSD file, it will be edited directly, 
rather than having a copy made.

SYSTEM

The System tab displays performance-related 
characteristics of Effects 2020.

Memory Usage

• System Usage: Specifies the amount of 
RAM that is used by the application. The 
maximum (default value) is 80%.

• VRAM Usage: Specifies the amount of 
video memory (VRAM) that is used by the 
application. The maximum (default) is 80%.

Scratch Folder Location

This setting lets you move or reset your memory cache, which helps speed editing operations while you’re 
running Effects. This is helpful if your system drive has limited space and wish to use a faster external drive 
as a cache. This cache information is purged each time you quit the application.

Performance

The Performance section is designed to help you optimize Effects for your specific setup. The adjustments 
you can make are as follows:

• Video Card Strength balances updating the preview of the image and the movement of brushes and 
gradient tool overlays. If your brush is sticking try turning it down. If you have a high-end video card try 
turning it up for faster preview updating.

• Fast Panning reduces the preview quality (makes it less sharp) while panning the photo to improve 
performance of panning.
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• Fast Preview reduces the preview quality (makes it less sharp) while painting or making other 
adjustments to improve paintbrush performance. This is off if you have a high-end video card.

• GPU Render uses the GPU (video card) to render preset thumbnails, exporting, printing, sharing and 
caching. This can greatly improve performance. It is on by default for systems that support it. It may be 
disabled on lower-end GPUs.
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